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List of Abbreviations

CPU central processing unit
PA phased array
RAM random-access memory
TCG time-corrected gain
TOFD time-of-flight diffraction
UT ultrasonic testing
VPA virtual probe aperture
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Important Information — Please Read Before Use

Intended Use

WeldSight software is designed to be used with the FOCUS PX acquisition unit and 
the OmniScan X3 flaw detector instrument in nondestructive inspection of 
commercial and industrial materials. 

Instruction Manual

This instruction manual contains essential information on how to use this Evident 
product safely and effectively. Before using this product, thoroughly review this 
instruction manual. Use the product as instructed.

Keep this instruction manual in a safe, accessible location.

Some of the details of software images in this manual may differ from your software 
display. However, the principles remain the same. 

Software Compatibility

WeldSight software is compatible with the FOCUS PX unit and the OmniScan X3 
instrument for data collection and analysis. 

IMPORTANT
Important Information — Please Read Before Use 9
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Safety Symbols

The following safety symbols might appear in the instruction manual:

 General warning symbol
This symbol is used to alert the user to potential hazards. All safety messages that 
follow this symbol shall be obeyed to avoid possible harm or loss of data.

Safety Signal Words

The following safety signal words might appear in the documentation of the software:

The CAUTION signal word indicates a potentially hazardous situation. It calls 
attention to a procedure, practice, or the like that if not correctly performed or 
adhered to may result in minor or moderate personal injury, material damage, 
particularly to the product, destruction of part or all of the product, or loss of data. Do 
not proceed beyond a CAUTION signal word until the indicated conditions are fully 
understood and met.

Note Signal Words

The following note signal words could appear in the documentation of the software:

The IMPORTANT signal word calls attention to a note that provides information that 
is important or essential to the completion of a task.

The NOTE signal word calls attention to an operating procedure, practice, or the like, 
that requires special attention. A note also denotes related parenthetical information 
that is useful, but not imperative.

CAUTION

IMPORTANT

NOTE
Important Information — Please Read Before Use10
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The TIP signal word calls attention to a type of note that helps you apply the 
techniques and procedures described in the manual to your specific needs, or that 
provides hints on how to effectively use the capabilities of the product.

Warranty Information

Evident guarantees your Evident product to be free from defects in materials and 
workmanship for a specific period, and in accordance with conditions specified in the 
Evident Terms and Conditions available at https://evidentscientific.com/evident-terms/.

The Evident warranty only covers equipment that has been used in a proper manner, 
as described in this instruction manual, and that has not been subjected to excessive 
abuse, attempted unauthorized repair, or modification.

Inspect materials thoroughly on receipt for evidence of external or internal damage 
that might have occurred during shipment. Immediately notify the carrier making the 
delivery of any damage, because the carrier is normally liable for damage during 
shipment. Retain packing materials, waybills, and other shipping documentation 
needed in order to file a damage claim. After notifying the carrier, contact Evident for 
assistance with the damage claim and equipment replacement, if necessary.

This instruction manual explains the proper operation of your Evident product. The 
information contained herein is intended solely as a teaching aid, and shall not be 
used in any particular application without independent testing and/or verification by 
the operator or the supervisor. Such independent verification of procedures becomes 
increasingly important as the criticality of the application increases. For this reason, 
Evident makes no warranty, expressed or implied, that the techniques, examples, or 
procedures described herein are consistent with industry standards, nor that they 
meet the requirements of any particular application.

Evident reserves the right to modify any product without incurring the responsibility 
for modifying previously manufactured products.

Technical Support

Evident is firmly committed to providing the highest level of customer service and 
product support. If you experience any difficulties when using our product, or if it 
fails to operate as described in the documentation, first consult the user’s manual, and 

TIP
Important Information — Please Read Before Use 11

https://evidentscientific.com/evident-terms/


10-027142-01EN, Rev. 4, July 2024
then, if you are still in need of assistance, contact our After-Sales Service.To locate the 
nearest service center, visit the Service Centers page on the Evident Scientific Web site 
https://www.evidentscientific.com/service-and-support/service-centers/.
Important Information — Please Read Before Use12
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Introduction

WeldSight software is designed for the inspection and analysis of welded components 
and base materials. It supports the FOCUS PX unit and the OmniScan X3 instrument 
for data collection and analysis.

This manual contains instructions for software installation, configuration, calibration, 
inspection, and analysis.

For instructions on how to use the FOCUS PX unit, refer to the FOCUS PX User’s 
Manual.

For instructions on how to use the OmniScan X3 flaw detector, refer to the OmniScan 
X3 User’s Manual.
Introduction 13
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1. Getting Started

This chapter describes how to install, configure, and start WeldSight software.

1.1 Minimum Computer and Software Requirements

You must meet the following minimum computer requirements to install and run 
WeldSight software.

• CPU: Intel Core i7 or Xeon E3 processor.
• RAM memory: 16-32 GB (DDR3 or better).
• Data storage drive: SSD.
• Network adapter:

— Dedicated 1 GB Ethernet card to connect to the acquisition unit.
— A second network card is required only if simultaneous connection to LAN is 

required during data collection or while connected to acquisition unit.
• 1600 × 1200 on 4:3 display (1920 × 1080 on 16:9 display) or higher display adapter 

and monitor resolution.
• A keyboard and a pointing device.
• Operating system and software:

— Microsoft Windows 10 and 11.
— Eclipse Scientific BeamTool version 9 or later is required to create new 

beamsets only, but not required for setup configuration, data acquisition, or 
analysis.

— Microsoft Excel 2016 or later is required for report creation.
Getting Started 15
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1.2 Installing WeldSight Software

This section provides instructions to install WeldSight software on a computer.

To install the software

1. Run the WeldSight installer program, located on the Evident distribution disk or 
website, and follow the on-screen installer wizard steps.

2. Enter the software license serial number, customer information, and activate the 
WeldSight license via the Internet (only required if a WeldSight USB software 
license key is not detected) (see Figure 1-1 on page 16).

Figure 1-1  Software license activation form

3. Close the software license activation form. If the form is closed without activating 
the license, WeldSight is enabled in Viewer Mode. In this mode, data files can be 
opened with limited analysis capability.
Chapter 116
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1.3 Network Card Optimization

This section explains how to configure and optimize the instrument connection. To 
achieve optimum performance and avoid data loss, the computer network card must 
have jumbo packets enabled. 

To optimize the network card under Windows 10

1. Open the list of network connections in the Windows Control Panel, and identify 
the connection used to connect to the instrument (see Figure 1-2 on page 17).

Figure 1-2  Selecting Properties

2. Right-click the network connection used to connect the instrument, and select 
Properties.

3. In the network card properties, select Configure, and select Advanced.
4. In the Advanced tab, under the Property list, browse to Jumbo Packets or Jumbo 

Frames, and change the value to 9014 bytes if not already set (see Figure 1-3 on 
page 18).
Getting Started 17
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Figure 1-3  Configuring Jumbo Packets

1.4 Starting WeldSight Software for Offline Analysis

WeldSight software can operate with or without a connected instrument. When not 
connected to an instrument, it operates solely in offline data analysis mode.

See “Offline Data Analysis” on page 157.

1.5 Preparing the OmniScan X3 Instrument for Data Collection

To prepare the OmniScan X3 instrument for data collection

1. Go to the Software Downloads section of our website, and navigate to the 
WeldSight section (see Figure 1-4 on page 19.

NOTE
Chapter 118
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2. Download the WeldSight Remote Connect .wrp file to your computer, and copy it 
to a USB memory stick (see Figure 1-4 on page 19).

Figure 1-4  WeldSight Remote Connect software download

3. Insert the memory stick into one of the USB ports on the OmniScan X3 instrument 
(see Figure 1-5 on page 19).

Figure 1-5  USB and LAN ports on the OmniScan X3 instrument

4. Connect the Ethernet cable between the LAN port on the OmniScan X3 
instrument and the LAN port on the system computer, and start up the OmniScan 
X3 (see Figure 1-5 on page 19).

USB ports

LAN port
Getting Started 19



10-027142-01EN, Rev. 4, July 2024
5. In the OmniScan Launcher, select REMOVABLE DRIVE, and choose WeldSight 
Remote Connect to install this system on the OmniScan X3 instrument 
(see Figure 1-6 on page 20).

Figure 1-6  Removable drive in OmniScan Launcher

6. Once installed, the WeldSight Remote Connect system will be added next to the 
existing systems available in the launcher.

7. Select the OMNISCAN X3 drive location in the launcher, and select WeldSight 
Remote Connect to start up this system (see Figure 1-7 on page 21).
Chapter 120
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Figure 1-7  OmniScan Launcher

8. When the start-up is complete, the OmniScan X3 instrument serial number and 
model are displayed, and the default IP address, 192.168.0.2 is assigned 
(see Figure 1-8 on page 22).
Getting Started 21
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Figure 1-8  WeldSight Remote Connect IP address

9. If an alternative IP address is required select the  button, and enter the 
address using the touch pad.

The OmniScan X3 instrument’s IP address must be on the same subnet as the system 
computer (by default, 192.168.0.1). If an alternative IP address is used, you must 
update the address in the WeldSight software.

The OmniScan X3 instrument is now ready to connect with WeldSight software.
Chapter 122
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1.6 Configuring the Network Connection to the OmniScan X3 
Instrument

To configure the network connection between the OmniScan X3 instrument and WeldSight 
computer

1. On the system computer, select Apps & Features and ensure Olympus NDT 
OpenView is installed. OpenView is installed during the WeldSight installation 
process, and it enables communication with the instrument (see Figure 1-9 on 
page 23).

Figure 1-9  Confirm OpenView installation

2. Open the WeldSight software and double-click the display indicator icon in the 
lower-right corner to open the Equipment form (see Figure 1-14 on page 28). The 

Equipment form can also be opened from the File > Equipment icon  on the 
command bar.
Getting Started 23
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3. Select Launch Configuration Tool. The configuration tool interfaces with the 
Windows network settings. It requires administrative permissions on the 
computer (see Figure 1-10 on page 24).

Figure 1-10  Configuration Tool launch

4. Select the Ethernet adapter that is connected to the OmniScan X3 instrument. 
Selecting the wrong Ethernet adapter will result in a fixed IP address. Ensure the 
desired Ethernet adapter is selected.
The current IP address for the selected adapter is displayed, and the red box 
indicates that it is assigned by DHCP.

5. Note the suggested IP address, and select Apply (see Figure 1-11 on page 25).
Chapter 124
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Figure 1-11  Configuration Tool IP address

6. If the default IP address (192.168.0.1) is already used on another adapter, the 
configuration tool suggests an alternate IP address (172.16.0.1). If this is the case, 
you must update WeldSight software to use this alternate IP address.

7. If an alternate IP address is used on the system computer (172.16.0.1), you must 
enter an IP address on the same subnet (172.16.0.2) in the WeldSight Remote 
Connect interface of the OmniScan X3 instrument.

8. Select Apply to update to the alternate IP address (see Figure 1-12 on page 26).
Getting Started 25
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Figure 1-12  Configuration Tool alternate IP address

The Devices list will update after setting the fixed IP address, and the OmniScan 
X3 instrument will be detected as a device able to connect to WeldSight software.

9. Select Test to verify the connection to the device (see Figure 1-13 on page 27).
10. Close the Configuration Tool. 

The Configuration Tool window must be closed to successfully connect WeldSight 
software to the OmniScan X3 instrument. Ensure that the window is not minimized or 
hidden behind another window.

NOTE
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Figure 1-13  Configuration Tool connection test

11. In WeldSight software, select Connect in the Equipment form.
The display indicator shows a check mark in a green circle when the connection is 
successful, which means that WeldSight software is ready for data collection 
(see Figure 1-14 on page 28).

For WeldSight software to automatically connect with the OmniScan X3 at start-up, 
begin by starting up the OmniScan X3 instrument with a network cable connection, 
then launch WeldSight software on the PC. Additionally, all configured IP addresses 
must remain unchanged.

NOTE
Getting Started 27
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Figure 1-14  Equipment Connected

12. If an alternate IP address is used in the configuration tool (172.16.0.1) it must be 
entered manually in Advanced Settings (see Figure 1-15 on page 29).

13. Close the Advanced Settings form, and select Connect (see Figure 1-14 on 
page 28).
The display indicator shows a check mark in a green circle when the connection is 
successful, which means that WeldSight software is ready for data collection 
(see Figure 1-14 on page 28).
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Figure 1-15  Equipment Advanced Settings

1.7 Configuring the Network Connection to the FOCUS PX unit

To configure the connection to the FOCUS PX unit

1. In WeldSight software, double-click the connection icon  in the footer.
2. Select Launch Configuration Tool.
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Figure 1-16  Launch Configuration Tool

3. Select the network adapter from the drop-down list to connect to the instrument. 
The current network IP address for the selected network card is displayed with 
the suggested default computer IP address to be used 198.168.0.1.

4. Select Apply to change the current IP address to the suggested IP address 
(see Figure 1-16 on page 30).

If not already done, start up the FOCUS PX unit. If using an OmniScan X3, 
see “Configuring the Network Connection to the OmniScan X3 Instrument” on 
page 23.

NOTE
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5. Select Detect if the instrument is not automatically detected. Upon successful 
connection to the instrument, a self-test is available to troubleshoot common 
problems. During the installation process, an exception is added to the Windows 
Firewall for WeldSight and OpenView software. This exception must be active to 
connect to the instrument.

6. Close the Configuration Tool and select Connect on the WeldSight Equipment 
form. After initial connection, the FOCUS PX unit will connect to the network 
card automatically when the WeldSight software is launched if the instrument is 
detected.

The connection icon with a green check mark  indicates success.

1.8 Starting WeldSight with the FOCUS PX Unit

To launch WeldSight software with a FOCUS PX unit

1. Turn on the system computer, and wait for Windows to complete the start-up 
process.

2. Connect the FOCUS PX unit to the appropriate network adapter of the computer, 
and turn on the instrument by pressing the power button (refer to the FOCUS PX 
Unit User’s Manual).

3. Select the WeldSight icon from the desktop or browse to WeldSight from the 
Windows Start menu.

1.9 Completing the Start-Up

After WeldSight software starts up, ensure that the instrument icon has a check mark 
in a green circle in the footer, indicating an active connection to the acquisition unit.

You do not need to be connected to the instrument to perform offline data analysis.
NOTE
Getting Started 31
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2. User Interface Reference

The WeldSight user interface is divided into several zones. Each zone regroups 
related settings, controls, readings, and views. The main zones of the user interface 
are described in Figure 2-1 on page 33 and detailed in the following sections.

Figure 2-1  WeldSight software user interface

Command bar

Dashboard Configuration forms

Data display

Footer and status indicators

Title bar
User Interface Reference 33
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2.1 Title Bar

Figure 2-2  Title bar

The title bar displays the WeldSight version number, license type, and the name and 
path of the file currently opened. See “Help and License Management Forms” on 
page 36.

2.2 Command Bar

The command workflow menus, File, Setup, Calibration, Inspection, and Analysis, 
each include icons to configure the inspection workflow. 

The icons update according to the properties of the active beamset selected in the 
command bar. The displayed icons update according to the testing technique used in 
the beamset, PA, UT, or TOFD.

Additional icons and fields are also part of the command bar, see Figure 2-3 on 
page 34 and Table 1 on page 35.

Figure 2-3  Command bar

Workflow menus
Chapter 234
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Table 1  Command bar options 

Option Description
Workflow menus See “File Menu Reference” on page 45.

See “Setup Menu Reference” on page 63.
See “PA Calibration Menu Reference” on page 89.
See “Inspection Menu Reference” on page 127.
See “Analysis Menu Reference” on page 137.

 
Dashboard toggle

Toggles the dashboard display on or off. The dashboard 
displays cursor positions and gate data readings for the 
active beamset.
See “Dashboard” on page 42

 
Second window

Selecting the second monitor icon launches a second 
window that can be positioned on a second screen.

 
Layout

The layout manager lists available displays for the active 
beamset type, PA, TOFD, UT, or TFM.

 
Gain

General and scan gain of the active beamset also editable 
in UT settings.

 
Active beamset

The beamset selected in this list updates the dashboard 
readings.

 
Active beam

Displays the current selected beam of the active beamset.
User Interface Reference 35
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2.2.1 Help and License Management Forms

The Help and License Management forms are launched from the icon in the 
command bar and contains software version information and the license management 
(see Figure 2-4 on page 36, Figure 2-5 on page 37 and Table 2 on page 37).

Figure 2-4  Help form

 
Display compression mode

Indicates when the display is compressed (C) or when it is 
in full resolution (HD).
Data display compression is managed automatically, and 
does not require configuration. 
When the number of data points in the selected data 
window exceeds the number of pixels on the display, the 
software is in compression mode and the icon is visible in 
the control bar. 
In compression mode, the most relevant point in either 
amplitude or TOF is represented by the color palette 
when one pixel may represent multiple data points. 

Help and license management

The Help and License Management form is launched 
from the icon in the command bar. It displays software 
version information, and allows license management. 
See “Help and License Management Forms” on page 36.

Table 1  Command bar options (continued)

Option Description
Chapter 236
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Figure 2-5  License Management form

Table 2  License types 

License Type Description
Viewer Viewer mode is free and enabled when no license is detected. 

Viewer mode allows analysis of data files with limited features.
WeldSight-A WeldSight-A (analysis) license allows offline analysis and 

reporting of data files and does not allow connection to an 
instrument for data collection.

WeldSight-I WeldSight-I (inspection) license allows offline analysis and 
reporting of data files and connection to an instrument for data 
collection. 
User Interface Reference 37
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2.3 Footer and Status Indicators

The software footer includes various controls and status indicators (see Figure 2-6 on 
page 38, Table 3 on page 38, and Table 4 on page 39).

Figure 2-6  Footer and status indicators

Table 3  Footer options 

Option Description
Encoder preset.

Invert encoder.

Scan Position in the scan axis.
Index Position in the index axis.
Acq Rate (Hz) Acquisition rate in Hertz.
Max Rate (in/s) Maximum rate in inches per second.

Selects the Piece or Calibration Block overlay.

Selects Manual or Automatic inspection 
mode. 
Manual - Inspection sequence controlled by 
you. 
Auto - Inspection sequence controlled by a 
PLC or remote software application. While in 
Auto Mode, the inspection sequence and 
certain setup parameters are disabled for edit.
The automatic inspection mode is enabled 
when the inspection sequence is managed by a 
PLC via the digital I\O or by a remote 
software application.
Chapter 238
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Displays the current software status of the 
inspection sequence.
See Table 4 on page 39.
Toggles the measurement units used in the 
display between millimeters and inches.
WeldSight software supports measurement 
units for metric (default) and imperial (inch). 
Switching between metric and inches is done 
by clicking Units in the footer or setting the 
option in Preferences > Appearance.
The connection icon displays the number of 
active instruments and their connection 
statuses. Double-clicking the connection icon 
launches the Equipment form. 
See “Equipment Manager” on page 46.

Table 4  Software states 

Soft State Value Description
Setup Setup mode is used to create and modify a configuration for 

inspection. The configuration can be saved in a setup file. When a 
setup file is loaded by an operator, WeldSight software automatically 
changes to Setup mode.

Setup (Busy) Certain software functions, such as calibration wizards, activate the 
Setup (Busy) mode. No external action is possible until the current 
action or pop-up window has been completed or resolved.

Collection Collection mode is activated when the inspection sequence is started 
for data collection. Certain functions are limited in the software until 
data collection is complete.

Analysis Analysis mode is enabled when the inspection sequence is stopped, 
or when a data file is opened for offline analysis. The acquisition 
instrument does not need to be connected for offline analysis of data 
files.

Table 3  Footer options (continued)

Option Description
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2.4 Configuration Forms

The forms are opened from the command bar icons and can be closed by reselecting 
the icon or by double-clicking anywhere on the form header. 

The form details change depending on the properties of the active beamset, and will 
adjust for PA, TOFD, and UT probe types (see Figure 2-7 on page 40).

Figure 2-7  Typical Configuration form
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2.5 Data Display Layout Form

The data display layout configuration form is launched from the icon in the command 
bar, and it enables you to drag and drop custom display layout types. Layouts can be 
created, edited, and recalled.

Data display layouts are saved with the setup configuration file. They also appear as a 
system setting that can be updated and recalled whenever WeldSight software is 
launched.

The layout displays included in the installer are designed for analysis only. They are 
not designed for setup and acquisition. To create custom display layouts and use the 
OmniScan X3 and FOCUS PX default layout lists, see “Display Layouts Overview” on 
page 158

The available data display layouts will change according to the selected probe types, 
PA, TOFD, and UT (see Figure 2-8 on page 41).

Figure 2-8  Layout form
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2.6 Dashboard

The dashboard appears pinned to the left side of the UI, and can be opened or hidden 

by selecting the dashboard icon  in the command bar.

The inspection sequence modes are selected from the dashboard and visible in the 
Soft State zone of the UI footer.

Different readings lists are available for PA, TOFD, and UT, and can be customized by 
double-clicking the readings area of the dashboard or by clicking on File/Readings in 
the command bar (see Figure 2-9 on page 42). For a description of each individual 
reading, see “Reading Abbreviation Reference” on page 173.

Figure 2-9  Dashboard
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2.7 Viewer Mode

Viewer mode is enabled when WeldSight software is launched without a software 
license or when no USB software key is detected. 

Viewer mode give you access to limited offline analysis features such as cursors, 
default display layout lists, and layout lists saved in the data file. Access to advanced 
features is disabled. See “Help and License Management Forms” on page 36.
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3. File Menu Reference

The file menu includes the usual file management commands, and often-used 
software settings (see Figure 3-1 on page 45 and Table 5 on page 45).

Figure 3-1  File menu

WeldSight setup configuration files carry the .osf extension for all Evident PA device 
models. Supported data file extensions are .opd, .odat, .nde, and .odf.

Table 5  File menu options 

Menu item Description

 
New

Select New to clear all existing beamsets and displays in 
preparation for a new setup configuration.

 
Open

Select Open to open a dialog box with a preset file filter 
according to the current software state.

TIP
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3.1 Equipment Manager

The Equipment manager displays the master instrument information and manages 
advanced settings to connect up to four instrument acquisition units for simultaneous 
inspection.

You can also launch the Equipment manager by double-clicking the connection icon 
in the footer (see Figure 3-2 on page 47 and Table 6 on page 48). Also see “Configuring 
the Network Connection to the OmniScan X3 Instrument” on page 23 and “Starting 
WeldSight with the FOCUS PX Unit” on page 31.

 
Save

Select Save to open a dialog box with a preset file filter 
according to the current software state.

 
Equipment

Under Equipment, you can manage the instrument 
configuration, Encoder, Digital Inputs, and alarm 
hardware configuration.
The Equipment form can also be launched by double-
clicking the connection icon in the footer.

  
Preferences

Under Preferences you can set the system default 
parameters for Beamset, Files, Appearance, and 
Application.

 
Readings

Readings are displayed on the dashboard and can be 
hidden or shown.

 
Palettes

The Palette manager associates color palettes available in 
the WeldSight system folder to the various data display 
types.

Table 5  File menu options (continued)

Menu item Description
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Figure 3-2  Equipment manager form
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Table 6  Equipment manager form options 

Option Description
Instrument 
Selection

Device Type Loads the appropriate firmware for supported Evident 
instrument models.a

Select OpenView to connect to an OmniScan X3 instrument 
and FOCUS PX unit. 
Select NDT Device API for connection to a QuickScan iX 
unit. 

Device ID Available with OpenView.
Connect up to four FOCUS PX instruments to acquire data 
simultaneously. Device ID 1 is the master unit. In single 
instrument acquisitions the Device ID is always 1. 
Select the device number from the drop-down menu to 
display information on any additional instrument used for 
acquisition.

Instrument Type Master - Primary instrument that controls the 
synchronization and encoding for the inspection sequence. 
In a single instrument acquisition, the Instrument Type will 
always be Master.
Instrument SN - The serial number of the selected 
instrument as read by the firmware.
Instrument Model - The instrument pulser configuration as 
read by the firmware.

Launch 
Configuration 
Tool

Select Launch Configuration Tool to open a configuration 
form independent of WeldSight that manages the network 
configuration between the instrument and the system 
computer.
The tool allows you to update instrument firmware, run self 
tests, assign an IP address, and read hardware 
configuration.

Connect Initiates the connection between the instrument and 
WeldSight. The connection is automatic if the network 
settings remain unchanged. A check mark in a green circle 
in the WeldSight footer indicates a successful connection.

Disconnect Disconnects the instrument from WeldSight.
Advanced 
Settings

Opens Advanced Equipment Settings for configuration of 
multi pod data acquisition, and additional device settings.
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For WeldSight software to automatically connect with the OmniScan X3 at start-up, 
begin by starting up the OmniScan X3 instrument with a network cable connection, 
then launch WeldSight software on the PC. Additionally, all configured IP addresses 
must remain unchanged.

Close the Configuration Tool before connecting the instrument to WeldSight. Keeping 
the Configuration Tool open prevents connection of the instrument to WeldSight.

Encoder Encoder Selecting encoders 1 or 2 for configuration of resolution and 
type.

Resolution Steps per count resolution of the selected encoder.
Type Select either quadrature or step and direction encoder type.
Invert Encoder Toggles encoder direction, negative or positive.

Digital 
Inputs

DIN 0
DIN 1
DIN 2
DIN 3

The digital inputs are programmable and enable remote 
inspection sequences initiated from a PLC, scanner 
hardware, or other external device to the digital I\O 
connector on the instrument. 
Supported commands are Encoder Reset, Toggle Firing, 
and Toggle Inspection. 
See instrument model user manual for connector wiring 
schematics, voltage specifications, and available DIN pins.

ZMQ 
Server / 
Event

Connect
Disconnect

The ZMQ Server enables remote inspection sequences 
initiated from third party software using a JSON protocol 
and ZeroMQ TCP/IP communication. 
Supported commands include Start Acquisition, Stop 
Acquisition, Name File, Load Setup, Read Soft State, Set Soft 
State, Preset Encoders, and Get Scan and Index Encoder 
Positions.

a.  OpenView requires installation of the Evident OpenView SDK included in the WeldSight 
installer. NDT Device API does not require additional software.

Table 6  Equipment manager form options (continued)

Option Description

NOTE

NOTE
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3.2 System Preferences

The system preferences allows you to set the default parameters for the setup and 
data collection tasks.

3.2.1 Beamset Tab

Use this tab to set default values for the beamset parameters (see Figure 3-3 on 
page 50 and Table 7 on page 51)

Figure 3-3  Beamset tab
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Table 7  Beamset tab options 

Option Description
PA Compression Sets the default compression value applied in Digitizer settings to 

new PA beamset creation.
TOFD Compression Sets the default compression value applied in Digitizer settings to 

new TOFD beamset creation.
UT Compression Sets the default compression value applied in Digitizer settings to 

new UT beamset creation.
Track Type Tracking will follow the maximum amplitude in Gate A or inside the 

whole UT range.
Headroom This value represent the amount of dB above 100% that WeldSight 

can use. A value of 12 dB (ratio 4:1) means that the data can be 
represented up to 400%.
The higher this value goes, the higher the signal can go without 
saturation, but the lower the resolution, because the bit quantity per 
data point is fixed.
Having a very high headroom but low bit resolution (8 bits) can 
even lead to non-linearity in the amplitude axis. Recommended 
values are 12 dB for 12 bits (400% limit), 6 dB for 8 bits (200%) and 
18 dB for 16 bits (800%).

Reference Amplitude Reference value for calibration.
Gate Threshold The default value of the gate threshold. Can be edited in gate 

settings.
Merge Resolution Sets the default value of data merge resolution. Can be edited before 

merging in the Merge section.
Dynamic Merge If switched On, WeldSight builds by default merge views that 

include the whole UT range (as opposed to only gated signals). 
While this view has benefits for analysis, it can slow down the 
software, because the view consumes a lot of RAM, even if not used.

Merge Data Mode Defines what data should be kept if it is overlapped during 
acquisition.
Replace: Typically used for one-line scan, if some data is overwritten 
(by running the encoder back and forth for example), only the last 
value is kept for every scan position.
Maximum: When some data overlaps, the A-scan kept is the one 
with maximum amplitude inside Gate A. This setting is typically 
used with raster scan, in particular when raster lines overlap. Only 
the highest amplitude data is kept on the overlap.
File Menu Reference 51



10-027142-01EN, Rev. 4, July 2024
3.2.2 File Tab

Use this tab to set default values for the file parameters (see Figure 3-4 on page 52 and 
Table 8 on page 52).

Figure 3-4  File tab

3.2.3 Appearance Tab

This tab allows you to change the various appearance settings of the software 
(see Figure 3-5 on page 53).

Table 8  File tab options

Option Description
Setup File Path Sets the default path for opening and saving .osf setup 

configuration files.
Data File Path Sets the default path for opening and saving data files.
Data Merge On Open Sets the Data Merge option in the file open dialog box. The option 

activates projection merge views on opening the file.
Chapter 352



10-027142-01EN, Rev. 4, July 2024
Figure 3-5  Appearance tab

3.2.3.1 Data Cursor

Use this form to set parameters for data cursors (see Figure 3-6 on page 54 and Table 9 
on page 54).
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Figure 3-6  Data Cursor form

Table 9  Data Cursor form options 

Option Description
Link Measure Cursor Links the blue sizing measure cursor position to the red sizing 

reference cursor so they can be moved simultaneously. When 
disabled, the red and blue sizing cursors move independently.

Show Amp Cursor Displays the sizing cursors on the amplitude axis of the A-scan 
display.

Color \ Width \ Opacity Allows customization of the appearance of the data cursor for 
all beamset types and displays.

Link Beam Cursors Links the data cursors of all beamsets for simultaneous 
analysis. Also available from right click on display header.

Snap To Peak Activates the snap to peak function when repositioning any 
sizing cursor. This is the same function as the snap to peak 
function on the dashboard but will refresh as the sizing 
cursors are repositioned, without selecting each instance from 
the dashboard. The option is also available by right clicking on 
the display header.
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How to differentiate Track To Peak versus Snap To Peak?

While these functions may look similar, they are not used in the same way. 

Snap To Peak will find the maximum peak amplitude within the area delimited by 
the reference and measurement cursors. If there are two data cursors in a view (C-
scan for example), both data cursor will snap to the maximum amplitude. The snap is 
performed after the movement of any cursor is done. 

Track To Peak is refreshed live, as the scan axis data cursor is moving. While the 
cursor is in movement, WeldSight will find the beam with the maximum amplitude 
inside Gate A and snap the beam data cursor on it.

3.2.3.2 Weld Overlay

Use this form to set parameters for weld overlays (see Figure 3-7 on page 55).

Figure 3-7  Weld Overlay form

Width \ Opacity \ Color 1 \ Color 2 settings allow customization of the appearance 
of the weld, calibration block, and CAD overlays for all beamset types and displays. 

Selecting the target icon  will apply the new appearance to the current data file 
(see Figure 3-7 on page 55).

3.2.3.3 Echo-Dynamics

Use this form to modify the Echo-Dynamics display options. The display is a linear 
interpolation of the color palette on the vertical and horizontal display axis 
(see Figure 3-8 on page 56 and Table 10 on page 56).

TIP
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Figure 3-8  Echo Dynamics form

Each display can be configured independently and saved with the display layout. The 
saved configuration includes the Window Mode for sizing cursors or data cursors. 

Select the target icon  to apply the preferences to the active display.

Table 10  Echo-Dynamics form options 

Option Description
Window Mode Data Cursor - Single slice display on the data 

cursors.
Sizing Amp - For use on Amp displays for 
maximum amplitude between the reference and 
measure cursors.
Sizing TOF - For use on TOF displays for minimum 
TOF (thickness) between the reference and measure 
cursors.
Data Envelope - Dynamic display that will envelop 
the data cursor as it is moved over an indication. 
Data envelope is refreshed on zoom, active beamset 
change, or display layout change.
Envelope All Beams - For use on Amp displays to 
visualize all beams between the reference and 
measure cursors.

Show Horizontal Enables the echo dynamic display on horizontal 
axis.

Show Vertical Enables the echo-dynamic display on the vertical 
axis.
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3.2.3.4 Layouts

Use this form to modify the display layout. 

Figure 3-9  Layouts form

These options load the default display layout list for the FOCUS PX unit typical of 
acquisition and the OmniScan X3 layout list typical of offline analysis.

3.2.4 Application Tab

Use this tab to modify the application preferences (see Figure 3-10 on page 57 and 
Table 11 on page 58).

Figure 3-10  Application tab

Size Provides a big and small option for the echo-
dynamic displays.

Table 10  Echo-Dynamics form options (continued)

Option Description
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3.3 Readings

Use this form to customize the readings that are displayed on the dashboard 
(see Figure 3-11 on page 59 and Table 12 on page 59). Individual reading 
abbreviations are described in Table 54 on page 173 and Table 55 on page 176.

Table 11  Application tab options 

Option Description
Bypass Analysis When a file is saved, this bypasses analysis mode and 

jumps directly to the next inspection setup. Use this 
option for high-production successive inspections where 
analysis is performed after data collection.

Application Type BeamTool - Displays the BeamTool icon in the Setup 
command bar for visualization of scan plans offline or 
for scan plan import using the BeamTool software for 
data collection.
OmniScan X3 - Displays the OmniScan icon in the Setup 
command bar for visualization of X3 data file beamset 
information used in data collection.

UFF Auto Automatically loads OmniScan .nde files with or without 
the OpenView SDK depending on file version. Any .nde 
files collected in the OmniScan X3 instruments running 
MXU 5.13 software or earlier require the SDK to gain 
access. Any .nde files collected with MXU 5.13 or later 
feature an open architecture HDF5 format and can be 
read by WeldSight or third-party software without the 
SDK. When disabled, the .nde version is not considered 
and will load based on the UFF Enable toggle selection.

UFF Enable Loads the .nde file via the domain and JSON without 
regard for file version. When disabled will load the .nde 
file via the OpenView SDK, and does not include 
benefits of the HDF5 file format.

Corrosion Displays the Corrosion Manager in the Analysis 
command bar.

BeamTool Version Selects BeamTool version 9 or version 10 to import scan 
plans used for data collection. You must set the 
BeamTool version as it is not automatically detected.
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Figure 3-11  Readings form

Table 12  Readings form options

Option Description
Beamset Type Select Phased Array, Conventional, TOFD, or TFM in 

the drop-down list.
Source Select Cursors, Gates, Sizing, Zone, or Corrosion in the drop-down 

list.
Cursors Toggle the available cursors. The list changes according 

to the selected Type and Source.
Gates Toggle the different Gate thresholds. The list changes 

according to the selected Type and Source.
Sizing Toggle the different ratios.
Zone Toggle the different zone maximums.
Corrosion Toggle the different thickness readings.

Show\Hide To customize the readings lists, select the Type and Source, and toggle 
readings on or off. Individual readings are described in Table 54 on page 173 
and Table 55 on page 176.
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New dashboard readings are visible when the active beamset is refreshed the first 
time.

Hovering the cursor above the readings listed under Show\Hide displays a tool tip 
description.

3.4 Palettes

The Palettes form associates color palettes available in the WeldSight system folder to 
the various display types.

Selecting the color palette for the display type will update all saved display layouts 
with the new color palette (see Figure 3-12 on page 61).

NOTE

TIP
Chapter 360



10-027142-01EN, Rev. 4, July 2024
Figure 3-12  Palette form

3.5 Report Form

Report options are available for weld and corrosion inspections, and the sections that 
make up the report can be included or excluded by selecting the toggles. 

Reports are generated from the Weld Manager and the Corrosion Manager forms. 

Under the Flaw Types section of this form, you can set the number of flaw types 
required, and each Flaw Type name entered in the table is also displayed in the pull-
down menu of the indication table records.

Indication table options are available for weld inspections. You can use the toggle 
buttons to include or exclude the fields appearing in the table (see Figure 3-13 on 
page 62). See “Reporting” on page 169 and “Indication Table Overview” on page 169.
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Figure 3-13  Report form
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4. Setup Menu Reference

Use the Setup menu to prepare the software for inspection (see  Figure 4-1 on page 63 
and Table 13 on page 63).

Figure 4-1  Setup menu

Table 13  Setup menu options 

Menu item Description

 
OmniScan X3 Viewer

This option is enabled in File >Preferences > 
Application > Application Type. Selecting OmniScan 
enables the OmniScan viewer in the File menu where 
probe, wedge, and beamset parameters are displayed.

  
BeamTool Import

This option is enabled in File >Preferences > 
Application > Application Type. Selecting BeamTool 
enables the pre-configured scan plan .ebwk files to be 
imported that include all parameters of the inspection.

 
UT Settings

The UT Settings menu enables you to access the 
General, Position, and Tx/Rx parameters.
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4.1 OmniScan X3 Viewer Form

Use the OmniScan X3 viewer form to see the configuration parameters (see  Figure 4-2 
on page 65 and Table 14 on page 65).

 

Digitizer

The Digitizer settings are for all beamsets in the 
configuration. The Time Base Resolution is 
configurable for each beamset.

 
Gates

Two detection gates A (red) and B (green) are available 
for time of flight, amplitude readings, and trigonometry.

 
TCG Manager

The TCG Manager allows you to import and export 
tables for repetitive use, edit points, and enables the 
overlay on the A-scan data display.

Table 13  Setup menu options (continued)

Menu item Description
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Figure 4-2  OmniScan X3 viewer form

Table 14  OmniScan X3 viewer form options 

Option Description
Probe Set Transducer and wedge model number.
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4.2 BeamTool Form

Use the Eclipse Scientific BeamTool (ESBT) form to manage the BeamTool settings 
(see Figure 4-3 on page 66 and Table 15 on page 67).

Figure 4-3  ESBT form

Probe Type PA, UT, or TOFD.
Pulser Instrument pulser connection to element 1 of the probe.
Beam configuration S-scan, Compound S-scan, E-scan, UT, TOFD, or TFM.
Wave type Shear or longitudinal
Aperture Element quantity, positions of first and last elements, and 

element step resolution.
Angle Start and stop positions, and beam resolution in degrees.
Focus Type Depth, sound path, projection, or unfocused
Focus Distance Focus distance from beam exit for depth and sound path, and 

focus distance from wedge face for projection.

Table 14  OmniScan X3 viewer form options (continued)

Option Description
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Replacing, deleting, or adding beamsets individually to a scan plan configuration will 
allow data collection but may not match the original scan plan. We recommend 
Editing the complete scan plan in the BeamTool .ebwk file before importing it into 
WeldSight software.

If the BeamTool scan plan has been changed in WeldSight, save and reload the .ebwk 
file to ensure the scan plan is stored correctly for data collection.

4.3 Piece Form

WeldSight software supports standard piece types for display overlays, including 
plate, pipe, and axial long seam welded components, volumetric data merge, and data 
modeling. You can import 2D CAD drawings in DXF file format for display overlays, 
and extruded or rotated for 3D data modeling. 

You can also import raster images for use as overlays on the volumetric Scan display.

Table 15  Eclipse BeamTool form options 

Option Description
Open Scan Plan Enables you to select the BeamTool .ebwk file for import into 

WeldSight for data collection. Upon loading the .ebwk scan 
plan, the beamset information is visible in the data viewer.

Load All Imports the entire scan plan including the piece and weld 
bevel, and all probes and beamsets.

Replace Current 
With Selected

Replaces the active beamset in the command bar with the 
current highlighted beamset in the data view list.

Add Selected Adds the highlighted beamset in the data viewer to the current 
configuration.

Delete Current Deletes the active beamset in the command bar.

NOTE

NOTE
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4.3.1 Piece Tab

You can use the Piece tab of the Piece form to modify the characteristics of plate, pipe, 
and axial long seam welded components (see Figure 4-4 on page 68 and Table 16 on 
page 69).

Figure 4-4  Piece tab
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Table 16  Piece tab options 

Option Description
Show Piece Enables the component piece overlay on the volumetric 

data displays.
Show Weld Enables the weld bevel overlay on the volumetric displays 

as part of the piece.
Weld Skip Count Number of rebound skips visualized on the volumetric S-

scan, D-scan, and B-scan displays. Weld skip count starts 
with 0 as the first leg, then 1 for the full V path, 2 for next 
rebound, etc. The weld skip number entered here will affect 
the number of skips included in the weld gate top view C-
scans.

Show HAZ Enables visualization of the HAZ (heat-affected zone) 
adjacent to the weld, and includes it in the weld gate top 
view C-scans.

HAZ width Sets the size of the HAZ adjacent to the weld, and includes 
it in the weld gate top view C-scans.

Show Caps Enables visualization of the weld crown and weld root as 
configured in the OmniScan X3 unit or in BeamTool.

Show Thickness Enables a repeating thickness line on the volumetric and A-
scan displays. 

Piece parameters Adjust parameters according to selected piece type.
Load Piece Replaces the current component piece configuration from 

BeamTool .EBP file import. 
Material Velocity Sets the default shear and longitudinal velocities associated 

to the component piece prior to calibration. Individual 
beamset velocities are edited or calibrated, and stored in UT 
Settings.

Calibration Block Name of the calibration block imported with the scan plan 
.ebwk file. The calibration block is visualized by toggling 
the overlay in the footer between piece and calibration 
block. The calibration block can be updated or replaced by 
importing a BeamTool .btcb file. 
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4.3.2 DXF Tab

The CAD drawing overlay is enabled by its presence in the OmniScan data file, or by 
importing a DXF file into WeldSight. When a CAD overlay is active, the component 
piece overlay is disabled and Show DXF is automatically enabled (see Figure 4-5 on 
page 70 and Table 17 on page 70).

Figure 4-5  DXF tab

Table 17  DXF tab options 

Option Description
Open *dxf File  Enables CAD overlay to be imported from a .dxf file.
Clear Clears the current CAD overlay from the data displays.
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4.3.3 Image Tab

The Image tab of the Piece form allows you to import common image file types and 
use the image as an overlay on the S-scan display (see Figure 4-6 on page 72 and 
Table 18 on page 72).

2D (Beamset Only) The 2D controls reposition the CAD overlay after import and can be 
edited individually for each beamset for multi-probe inspections. The 
2D controls are relative to the 0,0 mm position defined in the DXF file 
(horizontal, vertical, rotate, scale, hor flip, vert flip, top surface, and 
bottom surface).

Weld Skip Count Defines the number of repeat skips or reflections.
Show Skip Lines Enables multiple skip images of the CAD overlay.
Reflect Along Enables the CAD overlay to be reflected along the vertical or horizontal 

axis. Selecting None will result in no reflection.
3D Extrusion 3D extrusion enables the 2D CAD overlay to be converted to a 3D 

component by a linear or rotated extrapolation. The DXF file must be a 
closed loop polyline for the outside component definition, and it must 
not have open-ended line segments in the drawing.

Linear Extrusion Selection for square or rectangular geometry extruded on the length 
axis for 3D data modeling.

Rotated Extrusion Selection for round geometry typical of a flange extruded in degrees. 
After selecting Rotated, it is necessary to place red reference sizing 
cursor at 0 degrees, the blue measure sizing cursor at the inspection 
stop position (typically 360 degrees), and update the region to define 
the rotated part for 3D data modeling.

Update Part Update the extruded part geometry with the new offsets after edit.
Merge All Data Merges all beamsets for visualization of data after updating the 

extruded part. This is the same function available on the Analysis > 
Merge form and also available from CTL-V shortcut, and is necessary 
after any edits to the component piece geometry.

Table 17  DXF tab options (continued)

Option Description
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Figure 4-6  Image tab

Table 18  Image tab options 

Option Description
Show Image Enables the image overlay on the S-scan display. 

When enabled, Show Piece is disabled.
Open Image Enables import of the image overlay file. Compatible 

image file extensions for import include .png, .bmp, 
.gif, .jpg, and .jpeg. 

Clear Image Clears the current image file on the S-scan display.
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4.4 UT Settings Form

Use the UT Settings form to modify UT parameters.

4.4.1 General Tab

Use the UT Settings > General tab to adjust common UT settings (see Figure 4-7 on 
page 74 and Table 19 on page 75).

Image offsets Enables you to reposition and configuration of the 
image superimposed on the S-scan display. 

Table 18  Image tab options (continued)

Option Description
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n

Figure 4-7  General tab
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Table 19  General tab options 

Item Description
Beamset Gain Used to set the gain value in dB applied to all beams of the 

current beamset in the command bar.
Beam Gain Used to set the gain value in dB to the current beam (angle, 

or VPA) from the active beamset.
Start Used to set the starting location of the ultrasound axis 

(expressed in units of distance or time, according to the UT 
Mode setting).

Range Used to set the length of the ultrasound axis (expressed in 
units of distance or time, according to the UT Mode 
setting).

UT Mode UT: Used to change the ultrasound axis representation: 
Time, Sound Path, and True Depth. TOFD is set to Time 
and PA is set to True Depth in read-only.

Controls Set Reference Sets the current gain setting in dB as the reference 
sensitivity for amplitude compliance.

Clear Reference Clears the current reference sensitivity gain.
Set UT Range Sets the UT range from the red and blue sizing cursors on 

the UT axis.
Auto 80% Adjusts the general gain value for the signal in gate A to 

80% amplitude.
Hardware Instrument ID Instrument number of the current beamset. Used for multi-

pod data collection for compatible instruments.
Pulser Pulser number on the PA multiplexer that defines position 

of element number 1 of the current beamset. 
Voltage Used to set the voltage of the PA and UT pulsers.
Pulse Width Duration of the pulse wedge in nanoseconds. Set at time of 

beamset creation defaulted to 500 \ probe frequency 
editable in 2.5 nanosecond increments.

Rectification Used to set rectification of the A-scan signal. The four 
options are RF (radio frequency) non-rectified, HW+ (half 
wave positive), HW- (half wave negative), and FW (full 
wave).
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4.4.2 Position Tab

Use the UT Settings > Position tab to adjust probe properties (see Figure 4-8 on 
page 77 and Table 20 on page 78).

Receiver Smoothing Applies a video smoothing filter to the receiver defaulted 
to the probe frequency

Smoothing Filter Allows you to select the video smoothing frequency 
applied to the smoothing

Averaging Used to select an averaging value (1, 2, 4, 8, or 16) for the 
current beamset or UT channel. The averaging value 
divides the PRF value. For example, an averaging value 
from 1 to 4 causes an original PRF value of 1 kHz to drop to 
250 Hz but echo signals from all four pulses are averaged to 
produce a unique signal. Averaging is useful for reducing 
the noise on the received signals. An averaging value of 1 
corresponds to no averaging.

Filter Allows you to select predefined digital bandpass frequency 
filters.

Table 19  General tab options (continued)

Item Description
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Figure 4-8  Position tab
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4.4.3 Tx/Rx Tab

The Tx/Rx table displays element delay and offset information for individual beams 
in the active beamset (see Figure 4-9 on page 79).

Table 20  Position tab options 

Item Description
Probe Transducer Model of the transducer.

Wedge Model of the wedge.
Delay Probe delay in microseconds applied to all beams of the 

current beamset. Normally 0 µs unless manually 
calibrated. Editable in setup mode by positioning the red 
UT axis sizing cursor on the relevant signal, the blue UT 
axis sizing cursor on the desired depth or sound path, and 
selecting the icon to update the probe delay.

Scan Offset Mechanical offset of the probe center on the scan axis 
relative to 0 mm on the part.

Index Offset Mechanical offset of the probe on the index axis relative to 
0 mm weld centerline.

Skew Mechanical probe skew in degrees relative to the scan axis 
typically 90 and 270 degrees for opposing probes in weld 
line scans.

Beam Read-only information of the beam offsets and skew angles 
inside the wedge.

Total Offsets Combination of the beam offsets and probe offsets.
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Figure 4-9  Tx/Rx tab

4.5 Digitizer

The digitizer form displays the different settings and values used to process the data 
coming from the instrument.
Setup Menu Reference 79



10-027142-01EN, Rev. 4, July 2024
Figure 4-10  Digitizer
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Table 21  Digitizer form options 

Item Description
Digitizer Frequency (MHz) Effective digitizing frequency before 

compression is applied.
Sample Size Digitizer amplitude resolution.
Synchro Mode Synchronization of the pulse.
Recurrence Mode Used to manage cross-talk with multiple 

beamset configurations.
Beamset PRF (Hz) Pulse repetition frequency for each beamset in 

the configuration. Indicates the number of times 
per second a beamset is pulsed.

Recurrence (Hz) The effective recurrence is the number of 
ultrasonic pulses generated per second, for all 
beamsets included.

Setup Acq Rate (Hz) The cycle rate in setup mode
Max Scan Acq Rate (Hz) The maximum cycle rate
Interleave Changes the firing order to reduce ghost echoes 

in multiple beamset configurations.
Time Base 
& 
Resolution

Compression Compression factor. Combines the maximum 
amplitude of adjacent ultrasonics sample (the 
compression factor) into one, in order to make 
file size smaller. The effective frequency divided 
by the compression factor equals the net 
digitizing frequency.

UT Points Number of ultrasonic samples after the 
compression is applied.

Sound Path (mm) Distance between two ultrasonic points after 
compression, calculated with the current 
velocity.

Time (ns) Time between two ultrasonic points after 
compression.

Half Wavelength (mm) Calculation of the ultrasonic half wavelength 
based on current velocity.
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4.6 Gates

Two detection gates (A and B) and one A-scan synchronization gate are available for 
configuration. Menu options update according to the active beamset type (PA, UT, 
TOFD, or TFM). 

Limits Throttling by Displays the current limit used for throttling.
Data transfer (Hz) Limit rate at which the data can transfer from the 

instrument.
Digitization Time (Hz) Calculated rate limit to digitize all ascans and 

setup between ascans.
Hardware PRF (Hz) Limit according to the PRF of the instrument.
Max speed (mm/s) Scan speed according to the limit and scan 

resolution

Table 21  Digitizer form options (continued)

Item Description
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Figure 4-11  Gates form
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Table 22  Gates form options 

Item Description
Gate Name Selectable detection Gates A (red), Gate B (green), or 

synchronization Gate I (yellow).
Color Associated color of the selected gate.
Activate Activates the selected gate. Gate annotations appear on A-

scan and volumetric displays, and associated C-scans are 
activated in the display list.

Process While 
Moving

Allows dynamic offline update of the C-scan displays and 
readouts as the gate positions or threshold are 
repositioned.

Mode Ascan Sync Pulse - No A-scan synchronization. A-scan start position is 
set in UT Setting > General.
Gate I - A-scan start position is synchronized to Gate I 
(yellow).
Gate A - Gate B position is synchronized to Gate A (red).
Gate B - Gate A position is synchronized to Gate B (green).

Peak First - The detection gate is triggered when the maximum 
amplitude peak of the first waveform exceeds the gate 
threshold.
Max.- The detection gate is triggered when the maximum 
amplitude waveform reaches its peak.

Measure Peak - Measurement readouts and C-scan are calculated 
based on the maximum point exceeding the gate threshold.
Crossing - Measurement readouts and C-scan are 
calculated based on the first point that exceeds the gate 
threshold.

Position Start (mm) Start position of the selected gate.
Length (mm) Length of the selected gate.
Threshold (%) Amplitude threshold of the selected gate.
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4.7 TCG

The TCG form in the Setup menu enables manual creation of a PA or UT TCG one 
point at a time and allows you to import and export a TCG for use in other setup 
configuration files.

Thickness Thickness controls appear on the Gates form when the active beamset is a zero 
degree PA beamset or UT zero degree beam typical of corrosion inspection. The 
thickness controls can be edited from the Gates form or the Corrosion Manager, 
and are linked for each gate.
Source Defines the source of the thickness T reading and thickness 

C-scan. Selectable for detection gates A and B and 
synchronization gate I.

Min Defines the minimum thickness T reading to generate the 
low thickness color band (red if using default corrosion 
thickness color palette).

Max Defines the maximum thickness T reading to generate the 
high thickness color band (blue if using default corrosion 
thickness color palette).

Color Slider Enables manipulation of the color palette by adjustment of 
the low and high thickness limits.

Table 22  Gates form options (continued)

Item Description
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Figure 4-12  TCG form

Table 23  TCG form options 

Item Description
Reference Ref. Amplitude 

(%)
Reference amplitude for the TCG correction calculation, 
typically set at 80%.
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Controls All Beams Applies the current TCG correction to all beams at the same 
sound path position. When disabled, applies the TCG 
correction to the current beam only.

Add Point TCG is calculated using gate A maximum peak amplitude. 
The TCG point is stored in the table with dB correction and 
position.

Delete Point Deletes the TCG point selected in the table.
Clear TCG Gains Deletes the TCG gain for the selected point, and maintains 

the point position in the table.
Import TCG Imports a preconfigured .csv format TCG file, and applies 

it to the current beamset.
Export TCG Exports the TCG of the current beamset.

Table 23  TCG form options (continued)

Item Description
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5. PA Calibration Menu Reference

Use the Calibration menu to prepare the hardware and settings for inspection 
(see Figure 5-1 on page 89 and Table 24 on page 89).

Figure 5-1  PA Calibration menu

Table 24  PA Calibration menu options 

Menu item Description

 
Probe

Hardware validation of the probe.

 
Wedge

Wedge model and wedge wear validation.

 
Delay

Beam delay compensation.
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5.1 Probe Element Activity Validation Form

The phased array probe check validates the probe element, instrument pulser, and 
multiplexer integrity by generating a one element step, one element aperture E-scan 
for comparison of element activity (see Figure 5-2 on page 91 and Table 25 on 
page 92).

 
Auto Beam Sensitivity

Applies a measured gain offset (Automatic).

 
Manual Beam Sensitivity 

Applies a measured gain offset (Manual).

 
TCG

Time-corrected gain validation.

 
Velocity

Velocity validation.

Table 24  PA Calibration menu options (continued)

Menu item Description
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Figure 5-2  Probe Element Activity Validation form
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The probe check is essentially a hardware validation. It only needs to be performed 
once for each probe. The probe check does not depend on the current beamset, so any 
additional beamsets on the same probe do not need to be selected.

During the probe check, the software state will change to Setup (Busy). See “Footer 
and Status Indicators” on page 38.

Table 25  Element Activity Validation form options 

Option Description
Probe Transducer Displays the transducer model.

Velocity (mm/µs) Indicates the velocity of the medium used for the probe 
verification. The velocity is set by default to the velocity of 
Rexolite. It can be manually edited.

Pulser Displays the pulser number of the instrument multiplexer 
corresponding to element number 1 of the probe.

Results Results are a comparison between the auto-generated results and the user-
defined tolerances. When within tolerance, a green bar is generated. When out 
of tolerance, results in a red bar are generated for each check. Results will vary 
if checked with an angle wedge, a flat wedge, or a contact probe inspection 
with no wedge installed.
Inactive 
Elements

Displays the number of elements in the probe that exceed 
the beam to beam deviation tolerance in dB. The default is 
20 dB, which is typical of an angle beam wedge.

% of Inactive 
Elements

Displays the number of elements expressed as a percentage 
of all elements in the probe that are inoperable.

Adjacent 
Inactive 
Elements 

Displays the number of elements in the probe that are 
adjacent to a bad element.

Inactive Pulsers Displays the number of pulsers on the instrument 
multiplexer that are inoperable based on an initial pulse 
detected at the A-scan start.

NOTE

NOTE
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5.2 Wedge Validation Form

The phased array wedge check validates the wedge model and wedge wear by 
generating a one element step, one element aperture E-scan to compare wedge 
parameters against the measured values (see Figure 5-3 on page 94 and Table 26 on 
page 95).

Tolerance The tolerances are set to determine at what level or number of elements a red 
fail indicator is generated for the probe check.
Deviation (dB) Sets the beam to beam comparison of the minimum and 

maximum amplitude of each element in dB. This generates 
a green pass or red fail indicator. By default, 20 dB is used 
for angle beam wedges, and 2 dB for zero-degree wedges or 
flat test specimens.

Inactive 
Elements (%)

Displays the number of failed probe elements expressed as 
a percentage of total elements that are permitted to generate 
a green pass or red fail indication.

Adjacent 
element

Displays the number of elements in the probe that are 
adjacent to a failed element. Work procedures typically 
prohibit using a probe with two adjacent bad elements.

Controls Show A-scan Selecting Show A-scan enables visualization of the A-scan 
of each individual element for troubleshooting or 
optimizing the gate positions on particular probe models.

Element # Selects the element of the probe in the display from the first 
to the last element.

Gain Allows adjustment of the gain dB to optimize the signal in 
the gate.

Gate Start (mm) 
and Gate Length 
(mm)

Allows adjustment of the gate start position and length to 
optimize the entire probe.

Table 25  Element Activity Validation form options (continued)

Option Description
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Figure 5-3  Wedge Validation form
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Before performing a wedge check, ensure that the wedge is coupled properly to the 
probe and secured tightly with the set screws.

The wedge check is a hardware validation. It only needs to be performed once for 
each probe.

During the wedge check, the software state will change to Setup (Busy). See “Footer 
and Status Indicators” on page 38.

Table 26  Wedge Validation form options 

Option Description
Probe Transducer Displays the transducer model.

Wedge Displays the wedge model.
Velocity (mm/µs) Displays the velocity of the medium used for the probe 

verification. The velocity is set by default to the velocity of 
Rexolite. It can be manually edited.

Pulser Displays the pulser number of the instrument multiplexer 
corresponding to element number 1 of the probe.

IMPORTANT

NOTE

NOTE
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Results Results are a comparison between the wedge design parameters and the 
acoustic measurements. When wedge parameters are within tolerance, green 
bars are generated, and when out of tolerance, results in a red bar are 
generated for each check. 
First Element 
Height

Displays the height of the wedge at the element number 1 
position measured perpendicular to the wedge bottom. The 
wedge design height is displayed above the measurement.

Last Element 
Height

Displays the height of the wedge at the position of the last 
element measured perpendicular to the wedge bottom. The 
wedge design height is displayed above the measurement.

Wedge Angle Displays the calculated angle of the wedge based on the 
height parameters.

Tolerance The tolerances are set to determine at what deviation from the wedge design 
generates a green pass or red fail indicator.
Element Height Displays the tolerance between the design and measured 

height of element 1 and last element for an acceptable 
wedge validation.

Wedge Angle Displays the tolerance between the design wedge angle and 
the measured wedge angle for acceptance wedge 
validation.

Controls Show A-scan Selecting Show A-scan enables visualization of the A-scan 
of each individual element for troubleshooting or 
optimizing the gate positions on particular probe models.

Element # Selects the element of the probe in the display from number 
1 to last.

Gain Allows adjustment of the gain dB to optimize the signal in 
the gate.

Gate Start and 
Length

Allows adjustment of the gate start position and length to 
optimize the entire probe.

Update Beam 
Delays

Selecting Update Beam Delays will recalculate the beam 
delays based on new measured values. 

Table 26  Wedge Validation form options (continued)

Option Description
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Using Update Beam Delays is not recommended when the wedge is within tolerance. 
Wedges do not wear evenly, therefore, any adjustments based on measured results 
will be less accurate than the original design.

5.3 Beam Delay Form

The Beam Delay calibrator is used to compensate the beam precision by considering 
minor differences between the used PA calculation velocity and the component 
velocity. It can also compensate minor wedge wear to achieve a precise time of flight 
measurement (see Figure 5-4 on page 97 and Table 27 on page 98).

Figure 5-4  Beam Delay

IMPORTANT
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Table 27  Beam Delay form options 

Option Description
Reference Target Type The calibration reflector type used for the inspection.

SDH – Side-drilled hole target typical of angle beam 
inspection. Will result in a slight depth difference between 
beams for the different beam angles.
Radius – A calibration block with a radius designed to 
maintain a constant sound path distance for different beam 
angles typical of angle beam inspection.
Backwall – Component backwall or calibration block of 
fixed depth for zero-degree E-scan calibration. 

Target (mm) The distance to the target of SDH, radius, or backwall.
SDH Diameter 
(mm)

When SDH is selected, entering the size of the SDH will 
adjust the tolerances by considering the different depth of 
the SDH for each beam angle. Using a 0 mm SDH will put 
the wedge delay at the SDH center depth. 

Tolerance (mm) Sets the green tolerance window on the calibrator.
Smoothing 
Points

Using smoothing points will provide a linear extrapolation 
between beams to prevent a saw tooth correction. Using 3 
or 5 point quality is recommended for best results.

Show Points Displays the red point for every beam in the delay 
calibration window.

Calibration 
Zone

The red calibration zone on the S-scan is automatically set when the target 
depth is selected, and it can be manually adjusted. The red calibration zone is 
automatically set to 2.5 mm before the target and 2.5 mm after the target. For 
the wedge delay correction to be performed, the calibration zone must be over 
the target, and the target must be within the green calibrator zone. 

Controls Clear Envelope Resets the delay calibration window prior to performing 
the wedge delay correction.

Calibration Adjusts the beam delay of each beam to the appropriate 
target depth.

Clear 
Calibration

Clears the beam delay correction, and returns the beamset 
to the original beam delays.
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5.4 Auto Beam Sensitivity Form

Automatic beam sensitivity is used to apply a measured gain offset to each beam in 
the beamset based on a single calibration target. The beam gain sensitivity after 
calibration is visible in Setup > UT Setting > General > Beam gain, and can be 
manually edited or created from the Auto Beam Sensitivity form. The beam gain 
offset is added to the general gain for the beamset, and is independent from the TCG 
(see Figure 5-5 on page 99 and Table 28 on page 100).

Figure 5-5  Auto Beam Sensitivity form
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Table 28  Auto Beam Sensitivity form options 

Option Description
Reference Ref. Amplitude 

(%)
Sets the amplitude or screen height adjustment that will be 
calculated for each beam in the beamset (typically 80%). 

Tolerance (dB) Sets the green tolerance window in the calibration for 
verification of compliance. The default of 1 dB would put 
the green window at +\- 1 dB for amplitude compliance 
after calibration.

Smoothing 
Points

Using smoothing points will provide a linear extrapolation 
between beams to prevent a sawtooth correction. Using a 3 
or 5 point quantity is recommended for best results.

Show points Displays the red point for every beam in the delay 
calibration window.

Calibration 
Zone

The red calibration zone on the S-scan is set manually to cover the intended 
calibration target.
Gate Mode Depth – Sets the red calibration zone on the S-scan to a 

fixed depth for all beams used for a dynamic calibration 
where the probe is moved on the calibration block across 
each beam.
Sound Path – Sets the red calibration zone on the S-scan to 
a fixed sound path for all beams used for a static or 
dynamic calibration for each beam.

Start and Length Sets the red calibration zone position on the S-scan for 
coverage of all beams on the target.

Controls Clear Envelope Resets the sensitivity calibration window prior to 
performing the sensitivity calibration.

Calibration Adjusts the beam gain offset of each beam to 80% 
amplitude.

Clear 
Calibration

Clears the beam sensitivity correction, and returns the beam 
gain offset to 0 dB.

Copy Beamset Displays all compatible beamset for which the current 
sensitivity calibration can be copied. To copy a beam 
sensitivity calibration the corresponding beamset must be 
the same configuration included beam angle, beam 
resolution, and number of beams.

Copy Sensitivity 
Calibration

Copies the current beam sensitivity calibration to the 
selected beamset.
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5.5 Manual Beam Sensitivity Form

Manual calibration is used to apply a measured gain offset to each beam in the 
beamset based on a series of calibration targets from a static index position. 

The beam gain sensitivity after calibration is visible in Setup > UT Setting > General > 
Beam gain. The gain can be manually edited or created from the Manual Beam 
Sensitivity form. The beam gain offset is added to the general gain for the beamset, 
and is independent from the TCG (see Figure 5-6 on page 102 and Table 29 on 
page 102).

Status Green bar indicator when all beams are within the sensitivity tolerance 
window.
Red bar indicator prior to calibration completion.

Table 28  Auto Beam Sensitivity form options (continued)

Option Description
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Figure 5-6  Manual Beam Sensitivity form

Table 29  Manual Beam Sensitivity form options 

Option Description
Reference Reference 

Amplitude (%)
Sets the amplitude or screen height adjustment that will be 
calculated for each beam in the beamset (typically 80%).

Target Quantity Sets the number of targets that will be used in the 
calibration (minimum of 2). Best results are achieved with 
the first and last targets as close to the first and last beam in 
the S-scan as possible.
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5.6 TCG Sensitivity Form

The TCG (time-corrected gain) calibrator corrects the sensitivity of each beam for a 
series of targets over the inspection area, and allows you to calibrate the S-scan for all 
targets simultaneously (see Figure 5-7 on page 104 and Table 30 on page 105).

Calibration 
Zone

Gate Mode Depth – Sets the red calibration zone on the S-scan to a 
fixed depth for all beams used for a dynamic calibration 
where the probe is moved on the calibration block across 
each beam.
Sound Path – Sets the red calibration zone on the S-scan to 
a fixed sound path for all beams used for a static or 
dynamic calibration for each beam.

Gate Start and 
Length

Sets the red calibration zone position on the S-scan for 
coverage of all beams on the target.

Controls Reset Targets Clears the stored targets.
Add Target Each target in the S-scan must be selected one by one by 

moving the beam cursor and selecting Add Target. When 
the total number of targets are added the yellow amplitude 
trace is visible for the correction curve.

Calibrate Adjusts the gain offset of each target to 80% amplitude, and 
applies a linear extrapolation gain offset for beams between 
the targets.

Copy Beamset Displays all compatible beamsets for which the current 
sensitivity calibration can be copied. To copy a beam 
sensitivity calibration the corresponding beamset must be 
the same configuration, including the beam angle, beam 
resolution, and number of beams.

Copy Sensitivity 
Calibration

Copies the current beam sensitivity calibration to the 
selected beamset.

Table 29  Manual Beam Sensitivity form options (continued)

Option Description
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Figure 5-7  TCG Sensitivity form
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Table 30  TCG Sensitivity form options 

Option Description
Reference Enable TCG Enables the TCG on the A-scan and for availability of 

calibration.
Ref Amplitude 
(%)

Sets the amplitude or screen height adjustment that will be 
calculated for each beam and TCG point in the beamset 
(typically 80%). 

Starting Depth 
(mm)

Sets the depth of the first TCG target used for auto-
placement of gate position.

Separation (mm) Sets the separation between TCG targets used for auto-
placement of gate positions.

TCG Point 
Count

Sets the total number of TCG points to be used in the 
calibration.

Tolerance (dB) Sets the tolerance in dB for the green zone on each TCG 
point window.

Gate Mode Depth – Sets the TCG zones on the S-scan to fixed depth for 
all beams and TCG points.
Sound Path – Sets TCG zones on the S-scan to a fixed sound 
path for all beams and TCG points.

TCG Gain Limit 
(dB)

Sets the limit in dB of total points across the TCG limited by 
the instrument dynamic range.

Smoothing 
Points

Using smoothing points will provide a linear extrapolation 
between beams to prevent a sawtooth correction. Using a 3 
or 5 point quantity is recommended for best results.

Show Points Displays the red point for every beam in the TCG 
calibration window.

Controls Prepare to 
Calibrate

Sets the number of selected calibrator windows, and 
positions the TCG gates as per the start depth and 
separation.

Clear Envelope Clears all TCG calibration windows, resetting the 
amplitude trace.

Calibrate TCG 
Points

Adjusts the TCG gain of each target and beam to the 
reference amplitude.

Clear TCG Gains Resets the TCG clearing the gain on all beams and targets.
Export TCG Exports the current TCG to a .csv file for import to another 

beamset or successive inspections.
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5.7 Velocity

Performing a phased array velocity calibration is essential to validate a known 
velocity, but it may not be used to measure an unknown velocity (see Figure 5-8 on 
page 106 and Table 31 on page 107).

To measure an unknown velocity, we recommend using UT shear or a longitudinal 0-
degree beam on the parallel machined surfaces of the calibration block or test piece. 
We do not recommend using angle beam measurement on SDHs or radiuses to 
measure velocity, as this measurement method can lead to degraded results. 

Figure 5-8  Velocity form

TIP
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Figure 5-9  Velocity Calibration dialog box

Table 31  Velocity form options 

Option Description
Wave type Shear or longitudinal for use in the velocity calculation or 

validation.
Longitudinal (mm/us) Longitudinal velocity value stored for the current component 

piece.
Shear (mm/us) Shear velocity value stored for the current component piece.
Wedge Delay Delay in microseconds of the current beam calculated at time of 

beamset creation.
Mode UT scale for the ultrasound axis ruler used for the velocity 

calculation or measurement.
Target 1 Distance of target 1 defined by the red UT axis sizing cursor.
Target 2 Distance of target 2 defined by the blue UT axis sizing cursor.
Measure Material Velocity Calculates new velocity based on position for red and blue sizing 

cursors. A message is displayed with the old and new velocity 
for verification before proceeding. Selecting yes will recalculate 
all beam delays on all beamset with the velocity value 
(see Figure 5-9 on page 107). 
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6. UT Calibration Menu Reference

The options for calibrating conventional UT probe wedge delay, velocity, and TCG are 
available from the command bar when the active beamset is a conventional UT probe 
channel (see Figure 6-1 on page 109).

Figure 6-1  Conventional UT Calibration menu

6.1 Wedge Delay Calibration Form (WD) 

The UT wedge delay calibrator is a single point calibration that adjusts the probe 
delay to a specified depth or sound path at the selected wave type velocity 
(see Figure 6-2 on page 110 and Table 33 on page 111).

Table 32  Calibration menu options 

Menu item Description
 UT This option is used for UT calibration.
 TCG This option is used for TCG (time-corrected gain) 

calibration.
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Figure 6-2  Conventional UT Calibration form, WD tab
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6.2 Wedge Delay and Velocity Calibration Form 

The UT wedge delay and velocity calibrator is two-point calibration that adjusts the 
probe delay to a specified depth or sound path, and the material velocity for the 
current channel (see Figure 6-3 on page 112 and Table 34 on page 113).

Table 33  UT Calibration form, WD tab options

Option Description
Beamset Wedge Delay 

(µs)
The wedge delay of the probe being adjusted.

Wave Type Select Shear or Longitudinal velocity for the current 
channel.

Long (mm/µs)
Shear (mm/µs)

Displays the default material velocities for the component 
stored in Setup > Piece > Material Velocity.

Mode Select a mode for the calibration target.
Sound Path - Used for angle beam probes.
Depth - Used for zero-degree probes.

Target 1 Depth in mm or sound path in µs of the calibration target 
used for the wedge delay calibration. 
For 0-degree probes, a backwall reflector is typically used.
For angle beam probes, a radius is typically used. 
Locate the red reference cursor on the A-scan UT axis prior 
to calibration to define the signal of interest used for the 
wedge delay calculation.

Controls Calibrate Wedge 
Delay

Select to adjust the wedge delay for the signal at the red 
reference cursor position to the specified depth or sound 
path.
The new wedge delay is updated on the form, and stored in 
Setup > UT Settings > Position > Probe Delay.
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Figure 6-3  Conventional UT Calibration form, WD +Vel tab
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A dialog box appears with the new calculated velocity, and it can be accepted to 
update the channel or canceled if the velocity is out of tolerance, or if it is only 
measured for validation (see Figure 6-4 on page 114). The new calculated velocity is 
updated in Setup > UT Settings > Position > Beam > Calibrated Velocity.

Table 34  UT Calibration form, WD +Vel tab options 

Option Description
Beamset Wedge Delay 

(µs)
The wedge delay of the probe being adjusted.

Wave Type Select Shear or Longitudinal velocity for the current 
channel.

Long (mm/µs)
Shear (mm/µs)

Displays the default material velocities for the component 
stored in Setup > Piece > Material Velocity.

Mode Select a mode for the calibration target.
Sound Path - Used for angle beam probes.
Depth - Used for zero-degree probes.

Target 1 Position 1 in depth or sound path of the calibration target 
used for the wedge delay calibration. 
For 0-degree probes, a backwall reflector is typically used.
For angle beam probes, a radius is typically used. 
Locate the red reference cursor on the A-scan UT axis prior 
to calibration to define the first of two signals of interest 
used for the wedge delay calculation.

Target 2 Position 2 in depth or sound path of the calibration target 
used for the wedge delay calibration. 
Locate the blue reference cursor on the A-scan UT axis prior 
to calibration to define the second target.

Controls Calibrate Wedge 
Delay

Select to adjust the wedge delay for the signal at the red 
reference cursor position to the specified depth or sound 
path.
The new wedge delay is updated on the form, and stored in 
Setup > UT Settings > Position > Probe Delay.
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Figure 6-4  UT Velocity Calibration dialog box

6.3 UT Probe Velocity Calibration Form

The UT probe velocity calibrator is two-point calibration that calculates the material 
velocity of the material component based on the depth or sound path of two known 
targets (see Figure 6-5 on page 115 and Table 35 on page 116).
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Figure 6-5  Conventional UT Calibration form, Velocity tab
UT Calibration Menu Reference 115



10-027142-01EN, Rev. 4, July 2024
A dialog box appears with the new calculated velocity, and can be accepted to update 
the channel, or canceled if the velocity is out of tolerance, or if it is only measured for 
validation (see Figure 6-6 on page 117). The new calculated velocity is updated in 
Setup > UT Settings > Position > Beam > Calibrated Velocity.

Table 35  UT Calibration form, Velocity tab options 

Option Description
Beamset Wedge Delay 

(µs)
The wedge delay of the probe being adjusted.

Wave Type Select Shear or Longitudinal velocity for the current 
channel.

Long (mm/µs)
Shear (mm/µs)

Displays the default material velocities for the component 
stored in Setup > Piece > Material Velocity.

Mode Select a mode for the calibration target.
Sound Path - Used for angle beam probes.
Depth - Used for zero-degree probes.

Target 1 Position 1 in depth or sound path of the calibration target 
used for the wedge delay calibration.
For zero-degree probes, a backwall reflector is typically 
used.
For angle beam probes, a radius is typically used. 
Locate the red reference cursor on the A-scan UT axis prior 
to calibration to define the first of two signals of interest 
used for the wedge delay calculation.

Target 2 Position 2 in depth or sound path of the calibration target 
used for the wedge delay calibration. 
Locate the blue reference cursor on the A-scan UT axis prior 
to calibration to define the second target.

Controls Calibrate 
Material Velocity

Select to calibrate the material velocity.
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Figure 6-6  Velocity Calibration dialog

6.4 UT Probe TCG Calibration Form

The UT probe TCG calibration is used to consider sound attenuation over distances 
using a series of calibration targets, typically backwalls for zero-degree probes, and 
side-drilled holes for angle beam probes (see Figure 6-7 on page 118 and Table 36 on 
page 118).
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Figure 6-7  Conventional UT Calibration form, TCG

Table 36  UT Calibration form, TCG options 

Option Description
Reference 
Amplitude (%)

Sets the screen height percentage for each TCG point to be adjusted 
(typically 80%).

Add Point Prior to adding the first TCG point, the red gate A is positioned on the 
first TCG target in the A-scan display. Selecting Add Point calculates the 
dB required to adjust the point to 80% amplitude and stores it in the 
TCG table. Reposition gate A to successive targets and select add point 
to complete the TCG table.

Delete Point Deletes the current TCG point in the table.
Clear TCG Gains Clears all the gain values in the TCG table but maintains the point 

locations.
Chapter 6118



10-027142-01EN, Rev. 4, July 2024
Import TCG Enables import of preconfigured TCG for the current probe 
configuration from a .csv file.

Export TCG Exports the current TCG to a .csv file.

Table 36  UT Calibration form, TCG options (continued)

Option Description
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7. TOFD Calibrators

The TOFD calibrators are used to calibrate wedge delay, PCS (probe center 
separation), and material velocity. The calibrators are useful online, prior to data 
acquisition, or offline, in analysis.

7.1 TOFD Wedge Delay and PCS Calibration

The WD+PCS calibration calculates the probe wedge delay and the PCS 
simultaneously using two targets of known depth, typically the lateral wave and 
backwall signals (see Figure 7-1 on page 121 and Table 37 on page 122).

Figure 7-1  Conventional UT TOFD Calibration form, WD + PCS tab
TOFD Calibrators 121



10-027142-01EN, Rev. 4, July 2024
7.2 TOFD Wedge Delay (WD) Calibration

The TOFD wedge delay calibration uses a single target, typically the TOFD lateral 
wave at 0 mm, to set the time base of the A-scan to the intended position in depth 
(see Figure 7-2 on page 123 and Table 38 on page 123).

Table 37  TOFD calibration form, WD +PCS tab options 

Option Description
Beamset Wedge Delay 

(µs)
The combined wedge delay of the transmitter and receiver 
wedges for the current TOFD channel.

PCS (mm) Mechanical probe center separation of the two TOFD 
wedges in the scanner measured exit beam point to exit 
point on the wedges.

Velocity Longitudinal material velocity of the component.
Target 1 First target signal depth, typically the TOFD lateral wave at 

0 mm.
Target 2 Second target signal, typically the component backwall at 

part thickness.
Controls Calibrate Wedge 

Delay and PCS
Prior to calibration, set the red reference sizing cursor on 
the UT axis of the A-scan to target 1 position, typically the 
TOFD lateral wave at 0 mm. 
Set the blue measure sizing cursor to Target 2 position, 
typically the component back wall, and enter the thickness 
in Target 2. 
Select Calibrate Wedge Delay and PCS to update the new 
TOFD wedge delay and calculated PCS on the form and in 
Setup > UT Settings > Position. After calibration the TOFD 
Ur, Um, and Um-r sizing cursors are linearized for 
conversion of the time scale to mm readings on the 
dashboard. 
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Figure 7-2  TOFD Calibration form, WD tab

Table 38  TOFD Calibration form, WD tab options 

Option Description
Beamset Wedge Delay 

(µs)
The combined wedge delay of the transmitter and receiver 
wedges for the current TOFD channel.

PCS (mm) Mechanical probe center separation of the two TOFD 
wedges in the scanner measured exit beam point to exit 
point on the wedges.

Velocity Longitudinal material velocity of the component.
Target 1 TOFD signal depth, typically the lateral wave at 0 mm.
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7.3 TOFD Wedge Delay and Velocity

The WD + Velocity calibration calculates the probe wedge delay and the component 
velocity simultaneously using two targets of known depth, typically the lateral wave 
and backwall signals, or two side drilled holes in a multi-zone calibration block 
(see Figure 7-3 on page 124 and Table 39 on page 125).

Figure 7-3  TOFD Calibration form, WD + Velocity

Controls Calibrate Wedge 
Delay

Prior to calibration, set the red reference sizing cursor on 
the UT axis of the A-scan to target 1 position, typically the 
TOFD lateral wave at 0 mm. 
Select Calibrate to update the new TOFD wedge delay on 
the form and in Setup > UT Settings > Position. After 
calibration the TOFD Ur, Um, and Um-r sizing cursors are 
linearized for conversion of the time scale to mm readings 
on the dashboard. 

Table 38  TOFD Calibration form, WD tab options (continued)

Option Description
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Table 39  TOFD Calibration form, WD + Velocity tab options

Option Description
Beamset Wedge Delay 

(µs)
The combined wedge delay of the transmitter and receiver 
wedges for the current TOFD channel.

PCS (mm)
Velocity (mm/µs)
Target 1 First target signal depth, typically the TOFD lateral wave at 

0 mm.
Target 2 Second target signal typically the component backwall at 

part thickness.
Controls Calibrate Wedge 

Delay and 
Velocity
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8. Inspection Menu Reference

The Inspection menus are used to configure the setup file for data collection. It 
includes the mechanical sequence parameters for line or raster scanning, and the file 
saving parameters (see Figure 8-1 on page 127).

Figure 8-1  Inspection menu

Table 40  Inspection menu options 

Menu item Description

Motion

Use this option to set up scanning and encoder for data 
collection.

Data

Use this option to the select the parameters saved in the 
file when the inspection sequence is complete or stopped 
by the operator

Alarms

Use this option to set up the alarm parameters.
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8.1 Motion Settings Form

After configuring the beamsets for setup and calibration, prepare WeldSight for data 
collection in the Motion Settings form (see Figure 8-2 on page 128 and Table 41 on 
page 129).

Figure 8-2  Motion Settings form
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Table 41  Motion Settings form options 

Option Description
Scan 
Parameters

Type Available scan types for data collection are One Line Scan, 
Raster Scan, and Clock Inspection.
Line Scan – The one-line scan inspection sequence defines a 
linear data collection using a single encoder on the scan axis. 
In a line scan, only the scan axis settings are displayed.
Raster - The raster scan inspection sequence defines a 2D or 
bi-directional data collection using a primary encoder for 
the scan axis, and a secondary encoder for the index axis. In 
a raster scan, both the scan and index settings are displayed
Clock – The clock inspection sequence defines an inspection 
sequence collected at a fixed acquisition rate, without using 
an encoder.

Trigger on Used to set the inspection trigger for the data collection.
Encoder – Data is collected at the interval of the encoder 
movement, and is defined at the inspection resolution 
distance. Used with Trigger on Position data 
synchronization set in Setup > Digitizer.
Clock – Data is collected at a fixed interval based on the max 
scan acquisition rate when used with Position Stamped data 
synchronization located in Setup > Digitizer.

Scan 
Parameters 
(continued)

End Scan Used to set the stop inspection sequence automatically or 
manually. When the inspection sequence is stopped, the 
data is available for offline analysis and the software state in 
the footer changes to Analysis.
At End – The inspection sequence is automatically stopped 
at the end of the defined inspection length on the scan axis 
for one-line scan, and on the scan and index axes for raster 
scan.
Manual – Used to stop the inspection manually.

Preset on Start Used to preset the encoders to a fixed position at start of 
inspection. When On at the start of inspection, a one-line 
scan inspection sequence will set the encoder position to the 
preset value of the scan axis, and a raster scan inspection 
sequence will set the encoder positions to the preset values 
of the scan and index axis. 
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Scan Axis Encoder Determines whether encoder 1 or encoder 2 is used for the 
scan axis of the raster scan. In a raster scan, whichever 
encoder is selected for the scan axis, the other encoder is 
automatically selected for the index axis.

Start Sets the start position of the inspection sequence on the 
index axis.

Length Sets the relative position from start for the end of the 
inspection sequence.

Preset Encoder When Preset on Start is set to On, the encoder preset value is 
set on inspection sequence start.

Resolution Sets the interval between success data points on the index 
axis.

Invert Encoder Changes the polarity of the index axis encoder from positive 
to negative reversing the inspection direction.

Index Axis Encoder Determines whether encoder 1 or encoder 2 is used for the 
index axis of the raster scan. In a raster scan, whichever 
encoder is selected for the index axis, the other encoder is 
automatically selected for the scan axis.

Start Sets the start position of the inspection sequence on the 
index axis.

Length Sets the relative position from start for the end of the 
inspection sequence.

Encoder Preset When Preset on Start is set to On, the encoder preset value is 
set on inspection sequence start.

Resolution Sets the interval between success data points on the index 
axis.

Table 41  Motion Settings form options (continued)

Option Description
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8.1.1 Encoder Calibration Procedure

Start Calibration – Initiates encoder calibration wizard.

Stop Calibration – Saves traveled distance after encoder reposition for calibration

Yes \ No – Accepts calibration update dialog box.

To calibrate the encoder using the calibration wizard

1. Select Start Calibration and the active encoder position is set zero.
2. Move the encoder to the scan position entered for the calibration.
3. Select Stop and a pop-up message is generated with the original encoder 

resolution, and the new calculated resolution.
4. Select Yes or No to accept the new encoder resolution.

8.2 Inspection Data Form

The Inspection Data form allows you to configure the parameters saved in the file 
when the inspection sequence is complete or stopped by the operator. This includes 
the file version, inspection date information, and missed data point statistics after the 
inspection is complete (see Figure 8-3 on page 132 and Table 42 on page 133).

Encoder 
Calibration

Encoder Selectable for encoder 1 or 2, defines the encoder for the 
specified resolution in steps\mm, and the active encoder for 
the calibration wizard.

Encoder 
Resolution 
(steps/mm)

Sets the resolution of the encoder that determines the scan 
increments for the selected encoder. Can be set manually, 
and will update automatically after a calibration.

Scan Length Sets the length of the scan desired for the encoder 
calibration.

Start 
Calibration

Initiates the encoder calibration wizard for the selected 
encoder (1 or 2). Provides a step-by-step process to move the 
encoder a fixed distance for calculation or validation of the 
encoder step resolution

Table 41  Motion Settings form options (continued)

Option Description
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Figure 8-3  Inspection Data form
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Table 42  Inspection Data form options 

Option Description
Data File Directory Sets the default folder location for saving new data files.

Root Name Sets the default root file name for new data file collection. 
Appears in pop-up window on stop inspection.

Bypass 
analysis

Sets the software state mode directly to Setup the for next 
inspection, after the inspection has been stopped, bypassing 
analysis mode.

Auto Save 
Enabled

When On, it automatically saves the file when the inspection 
is stopped to the default location.

Confirm When On, a File Save window appears when the inspection 
is stopped so that the file name and location can be 
confirmed or edited.

Auto-index Increments an index number, 1,2,3 etc., after the file name 
for repeat inspections.

File Size Displays the size of the current data file in MB, based on 
number of probes, scan size, resolution, etc.

Device Type Displays the instrument model used to create the data file.
Master Device 
SN

Displays the serial number of the instrument used to collect 
the current data file. For instruments compatible with multi-
pod data acquisition, only the master serial number is 
displayed.

Acquisition 
Version

Displays the original software version used for data 
collection.

Acquisition 
Date

Displays the date of the original data file creation.

Re-save 
Version

Displays the software version used for offline resave of the 
data file. If blank, the data file is in the original software 
version.

Re-save Date Displays the date that the data file was resaved offline.
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Set the position of the red and blue sizing cursor on the scan axis to the inspection 
area, and the statistics will refresh for this area.

8.3 Alarms

Alarms are available via the digital I\O, and will provide an output from the 
instrument for an audio or visual alarm device when a signal is detected in one or 
more of the detection gates for the specified configuration.

Alarms are created for the active beamset and stored in the Alarms table. When active, 
each alarm appears in the dashboard under the readings and will change from green 
to red when an alarm condition is detected (see Figure 8-4 on page 135 and Table 43 
on page 135).

Statistics The statistics generated from one-line scan data files. It displays the 
information between the sizing cursors on the scan axis, regarding missed 
and adjacent data points, for procedure or code compliance. The statistics will 
update as the sizing cursors are repositioned at the beginning and end of the 
line scan.
Total Data 
Points

Displays the number of data points between sizing cursors 
on the scan axis.

Missed Data 
Points

Displays the number of data points that were missed or 
without data between the sizing cursors on the scan axis.

Percent Missed Displays the number of missed data points as a percent of 
total data points between the sizing and cursors on the scan 
axis.

Adjacent 
Missed Points

Displays the number of missed data points that are adjacent 
to another missed data point between the sizing cursors on 
the scan axis.

Table 42  Inspection Data form options (continued)

Option Description

TIP
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Figure 8-4  Alarms form

Table 43  Alarms form options 

Option Description
Alarm 
Parameters

Gate Gate A or gate B selection for the current alarm.
Threshold (%) Amplitude threshold of the detection gate to trigger an 

alarm. The value is set in the gate menu of the current 
beamset, and is displayed as read-only on this form.

Threshold type Selectable as above threshold or below threshold to trigger 
the alarm.

Counts Before 
Alarm

Sets the number of successive data points meeting the 
amplitude threshold to trigger an alarm condition.

Hardware 
Output

Sets the alarm output on the digital I\O connector of the 
instrument for the alarm hardware interface.

Hardware 
Duration (sec)

Sets the number of seconds that hardware will generate the 
alarm on the digital I\O output after alarm condition is 
detected.

Alarm Label Custom name for the current alarm.
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Controls Create Alarm Creates the alarm for the active beamset in the table for the 
current configuration.

Remove 
Selected Alarm

Removes the highlighted alarm from the table.

Table 43  Alarms form options (continued)

Option Description
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9. Analysis Menu Reference

WeldSight is useful for offline analysis of data files collected in WeldSight software, or 
collected with compatible instruments such as the OmniScan series flaw detectors. 
You will find the list of supported file extensions under the File > Open dialog box.

Figure 9-1  Analysis menu

Table 44  Analysis menu options 

Menu item Description

Merge

Use this option to analyze multiple PA beamsets or TFM 
modes using volumetric side, end, and top view 
displays.

Modeling

Use this option to model standard geometry such as 
plate, pipe, and axial long seam components.

Weld

Use this option to analyze and report weld inspection 
data.
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9.1 Merge

The merge functions allows you to analyze multiple PA beamsets or TFM modes 
using volumetric side, end, and top view displays.

9.1.1 A-Scan Merge Data Type

The A-scan data type is used for merging PA beamsets typical of weld inspection, and 
is limited to one line scan inspections. The processed volumetric merge displays are 
not saved to file, and must be re-merged to realize in the data displays.

Figure 9-2  A-scan Merge Data form

Corrosion

Use this option to analyze and report material loss 
inspection data.

Table 44  Analysis menu options (continued)

Menu item Description
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Table 45  A-scan Merge Data form options 

Option Description
Controls Data Type Select AScans.

Merge Gain 
(dB)

The PA volumetric, side, end, and top merge views have a 
processed gain that is applied off line and is independent 
of the general gain, beam gain offset, and TCG. Editing the 
merge gain applies only to the merge display and does not 
apply to the original beamset groups.

Merge 
Auto 80 

Select this button to automatically set the merge data point 
to 80% amplitude.

Merge 
Resolution 
(mm)

A multiple beamset volumetric merge is usually performed 
at lower resolutions than the original beamset resolution, 
typically around 0.25 to 1 mm. The system computer’s 
ability to merge large files, merge beamsets at a high 
resolution, and the time required to complete the merge 
process is dependent on RAM, CPU, and GPU 
specifications. See “Minimum Computer and Software 
Requirements” on page 15.

Show Data 
Cursor

Displays the slice and projection data cursors on the 
volumetric merge side, end, and top displays.

Index Axis
UT Axis 
Scan Axis 
(mm)

Displays a volumetric merge as a single Slice of the data, or 
as a Projection of all data between the data cursors. This 
function is independently available for each axis. Selecting 
Slice will enable a single merge gate cursor on the axis, and 
selecting Projection will enable two data cursors to define 
an area.

Refresh Soft 
Gain

When enabled, changing the gain of an individual beamset 
automatically refreshes the volumetric merge display 
amplitude. When disabled, the gain changes to individual 
beamsets will not refresh until the beamsets are merged 
again.
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9.1.2 C-scan Merge Data Type

The C-scan data type is used for merging PA beamsets, typically used for corrosion or 
composite inspections. It is compatible with line and raster scan inspections. 
Processed C-scan merge displays are not saved to file, and must be re merged to 
appear in the data displays.

Polar 
Interpolation

The polar interpolation is used for piping, flanges, or any inspection 
performed on circular or radial geometry. It converts the scan axis distance 
to degrees, enabling polar display views.
Scan Start Places the red sizing cursor at the start of the inspection on 

the scan axis of any display and enters the position, 
typically 0 degrees represents 12 oʹclock on the part.

Scan End Places the blue sizing cursor on the scan axis at the end of 
the inspection and enters the position, typically 360 
degrees represents the full circumference of the part.

Update Region 
button

Select Update Region to convert the scan axis distance to 
degrees on the polar displays.

Controls Merge Skips Displays individual skip legs or all legs in the polar merge 
displays.

Skips to Plot Select All or an individual skip leg to be visualized in the 
polar merge displays.

Merge button Select Merge to perform the A-scan volume merge, after 
which, the data is visible in the processed merge side, end, 
and top view displays. Use the Alt+V keyboard shortcut to 
merge all beamsets, and Alt+C to merge the current 
beamset.

Table 45  A-scan Merge Data form options (continued)

Option Description
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Figure 9-3  C-scan Merge Data form

Select Merge to perform the C-scan merge, after which, the data from all beamsets is 
visible in the processed Thickness C-scan display.
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9.1.3 TFM Merge Data Type

The TFM data type is used for merging TFM modes and is limited to one line scan 
inspections. Processed volumetric TFM merge displays are not saved to file and must 
be re merged each time the file is opened.

Table 46  C-scan Merge Data form options 

Option Description
Controls Data Type Select Cscans

Merge Gain 
(dB)

The PA TOF and Thickness C-scans have a processed gain 
that is applied off line and is independent of the general 
gain, beam gain offset, and TCG. Editing the merge gain 
will apply only to the merge display and does not apply to 
the original beamset groups.

Merge 
auto 80 

Automatically sets the merge data point to 80% amplitude.

Index axis 
(mm)
Scan axis (mm)

The scan and index offsets allows you to reposition each 
beamset in the merged C-scan by taking into account 
scanner wander and data overlap between inspections. 
Adjust the scan and index offsets for each beamset to align 
the data.

Angle (deg) The angular position of each beamset can be rotated in the 
merged C-scan to account for data misalignment. Adjust 
the rotation for each beamset to align the data.

Beamset 
Selection

Compatible PA beamsets with C-scan merge are displayed 
in the table. Beamsets are included or excluded from the 
merge by the check box prior to performing the merge.
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Figure 9-4  TFM Merge Data form
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Table 47  TFM Merge Data form options 

Option Description
Controls Data Type Select TFM.

Merge Gain 
(dB)

The PA TOF and Thickness C-scans have a processed gain 
applied off line that is independent of the general gain, 
beam gain offset, and TCG. Editing the merge gain will 
apply only to the merge display and does not apply to the 
original beamset groups.

Merge 
auto 80 

Automatically sets the merge data point to 80% amplitude.

Show Data 
Cursor

Displays the slice and projection data cursors on the 
volumetric merge side, end, and top displays.

Index Axis
UT Axis 
Scan Axis 
(mm)

Allows you to visualize a volumetric merge as a single 
Slice of the data, or as a Projection of all data between the 
data cursors. This function is available independently for 
each axis. Selecting Slice enables a single merge gate cursor 
on the axis, and selecting Projection enables two data 
cursors to define an area.

Refresh Soft 
Gain

When enabled, changing the gain of an individual beamset 
automatically refreshes the volumetric merge display 
amplitude. When disabled, gain changes to individual 
beamsets will not be refreshed until the beamsets are 
merged again.

Beamset 
Selection table

Compatible TFM beamsets are displayed in the table. 
Before merging, use the check boxes to include or exclude 
beamsets.

Polar 
Interpolation

The polar interpolation is used for piping, flanges, or any inspection 
performed on circular or radial geometry to convert the scan axis distance to 
degrees to enable polar display views.
Scan Start Places the red sizing cursor at the start of the inspection on 

the scan axis of any display and enters the position, 
typically 0 degrees represents 12 oʹclock on the part.

Scan End Places the blue sizing cursor on the scan axis at the end of 
the inspection and enters the position, typically 360 
degrees represents the full circumference of the part.

Update Region 
button

Select Update Region to convert the scan axis distance to 
degrees on the polar displays.
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9.2 Modeling

Modeling is available for standard plate, pipe, and axial long seam component 
geometries. For the base sketch, you can import DXF files containing closed loop 
polyline geometries. Modeling is visualized from the Simulation display available in 
the display list or selected from the default layouts.

Controls Merge Select Merge to perform the TFM merge after which the 
data is visible in the processed merge side, end, and top 
view displays. Shortcut ALT-V is available for TFM merge 
of all beamsets.

Table 47  TFM Merge Data form options (continued)

Option Description
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Figure 9-5  Modeling form
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Table 48  Modeling options 

Option Description
Part Rendering Show Part Displays or hides the component part.

Show CAD Displays or hides the 3D part from .dxf overlay if present.

Transparency  Adjustable from 0–250 sets the opacity on the part to 
enhance the data.

Show Wire 
Frame

Displays or hides the part frame.

Show Caps If present in the data file, displays or hides the weld cap 
geometry.

CAD Cross 
Section

Displays or hides the .dxf cross section if present.

Beamset Current / All Toggles between current active probe or all probes if 
present.

Show Probe Displays or hides the probe.

Show 
Elements

Displays or hides the probe elements and element start and 
end numbers.

Show Delays Displays or hides the beam delay graphic on the probe.

Show 
Simulation

Displays or hides the beam simulation.

Show Beamset Displays or hides the PA beamset on the part.

Show 
Rebound

Displays or hides the PA beamset on first skip of 
component surface if extended through the part.

Show 
Extended

Displays or hides the complete beamset UT range without 
skip in part.
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9.3 Corrosion Manager

The Corrosion Manager is useful for analyzing and reporting material loss inspection 
data using zero-degree phased array and UT probe raster scans. The corrosion 
workflow is designed around the thickness T reading, thickness C-scan display, and 
thickness C-scan gate source configuration.

Corrosion display layout: This display layout is present in the default layout list and 
can be edited and saved. When a corrosion data file is opened, the Corrosion display 
in layout list is automatically loaded.

Corrosion Merged display layout: This display layout is present in the default layout 
list and can be edited and saved. The Corrosion Merged display is used for analysis 
of C-scan that has been file merged, and C-merged.

Data Data is available after TFM or A-scan data merge.
Show Data Displays or hides the current data merge on the part.
Process While 
Moving

When selected, enables dynamic modeling update as the 
merge gate selectors are repositioned. Processing time and 
refresh dependent on file size and computer specifications. 

Number of 
Slices

Resolution of the data image is dependent on acquisition 
settings. Defaults to inspection scan axis resolution.

Upsampler 
Filter

Improves the data image by increasing the spatial 
resolution between points while keeping the 2D 
representation.

Median Filter Applies a Median image filter to the data that removes 
noise while maintaining precision edges. The time required 
to complete the process is dependent on the system 
computer specifications including RAM, CPU, and GPU. 
See “Minimum Computer and Software Requirements” on 
page 15.

Smoothing Applies a smoothing filter to the data.
Threshold (%) Crops the data at the specified threshold. Use to remove 

low amplitude data for flaw visualization.

Table 48  Modeling options (continued)

Option Description
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Figure 9-6  Corrosion form
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Figure 9-7  Cscan Edit form
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Table 49  Corrosion form options 

Option Description
Thickness 
Cscan

Merge view 
toggle

Automatically loads the Corrosion Merged display layout, 
and all C-scan merged data is visible in the display.

Source Defines the source of the thickness T reading and thickness 
C-scan. Selectable for detection gates A and B, and 
synchronization gate I.

Color Slider Enables manipulation of the color palette by adjustment of 
the low and high thickness limits.

Min Defines the minimum thickness T reading to generate the 
low thickness color band (red if using default corrosion 
thickness color palette).

Max Defines the maximum thickness T reading to generate the 
high thickness color band (blue if using default corrosion 
thickness color palette).

Floating Gate 
toggle

Adjusts the leading edge thickness T reading to be 
measured from the -6 dB amplitude position from peak 
instead of the first point over gate threshold. This option is 
used to improve the accuracy of thickness readings in data 
with varying amplitude waveforms.

Current Data 
Point

Thickness 
(mm) 

Displays the thickness T reading of the current data point. 
Dependent on the C-scan source, gate measure mode 
configuration, UT settings, compression, and point 
resolution on UT axis.

Metal Loss (%) Displays the percentage of metal loss for the current 
thickness T reading, based on the nominal thickness. 

Nominal (mm) Displays the nominal thickness of the material used to 
calculate the percentage of metal loss.
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Control Icons
 Snap to 

thinnest

When selected, snaps the crosshair position of the scan and 
index data cursors to the thinnest area in the visible C-scan 
display. With Cursors enabled, snaps the crosshair 
position of the data cursors to the thinnest area in the zone 
created between the sizing cursors.

 Next 
thickest

Moves the data cursors to the next thickest data point in the 
visible image of the C-scan, or if cursors are enabled, the 
next thickest data point in the zone between the sizing 
cursors.

Previous 
thinnest

Moves the data cursors to the next thinnest data point in 
visible image or zone between the sizing cursors.

 Cursor 
toggle

Displays or hides the sizing cursors on the data displays.

C-scan Edit 
form

Selecting the C-scan Edit button will pop out the C-scan 
edit form (see Figure 9-7 on page 150). It can be 
repositioned closer to the area being analyzed. The C-scan 
edit form is used to edit the thickness C-scan to recover 
points that were detected below gate threshold, and to 
clear or edit points or areas of erroneous readings.

Erase \ Edit 
Selection

Individual data points or areas can be removed or edited to 
a specific thickness by applying the Erase or Edit toggle. 
Erasing a point or area turns the pixels gray and excludes 
the point from statistics. Editing a point or area assigns a 
specific thickness and pixel color regardless of A-scan gate 
detection.

Undo Selecting Undo clears the last point or area that was edited.
Clear Selecting Clear erases all edited points on the Cscan.

Table 49  Corrosion form options (continued)

Option Description
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Cscan Statistics Total Points Displays the total number of data points in the thickness C-
scan.

Erased Points Displays the total number of erased data points in the 
thickness C-scan.

Edit Points Displays the total number of edited points in the thickness 
C-scan.

Maximum Displays the thickest point in the thickness C-scan.
Minimum Displays the thinnest point in the thickness C-scan.
Average Displays the average thickness of all data points in the 

thickness C-scan.
RMS Displays the root mean square (RMS) thickness of all data 

points in the thickness C-scan.
Standard 
Deviation

Displays the standard deviation between all data points in 
the thickness C-scan.

Table 49  Corrosion form options (continued)

Option Description
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Cluster 
Analysis 
Sizing

The cluster analysis feature identifies areas of wall loss based on a 
percentage of material loss or on a defined specific thickness. Areas with a 
wall loss value meeting the filter criteria are automatically added to the 
corrosion indication table and annotations appear on the thickness C-scan 
display.
You can set the cluster analysis gap tolerance and merge overlap under 
Setup >Reporting > Corrosion Report. This will determine the number and 
size of the areas.
When the sizing cursors are hidden, the cluster analysis is performed on the 
entire thickness C-scan. When the cursors are displayed, the cluster analysis 
is performed on the zone between the cursors. Each time Run is selected, 
lines are added to the corrosion table.
Material Loss 
(%) 

Sets the percentage of material loss used for the cluster 
analysis detection. Editing the percentage of material loss 
will update the thickness value calculated from nominal.

Thickness 
(mm) 

Sets the thickness value used for the cluster analysis 
detection. Editing the thickness will update the material 
loss percentage calculated from the nominal value.

Min Size Index 
(mm) 

Sets the minimum size on the index axis for an area to be 
recorded in the cluster analysis. Indications smaller than 
the minimum size are ignored and not included in the table 
records.

Min Size Scan 
(mm)

Sets the minimum size on the scan axis for an area to be 
recorded in the cluster analysis. Indications smaller than 
the minimum size are ignored and not included in the table 
records.

Run Select Run to apply the current filter criteria over the 
thickness C-scan, to populate the corrosion defect table and 
areas on the thickness C-scan.

Clear Select Clear to remove all records in the corrosion table and 
remove the cluster annotations on the thickness C-scan.

Table 49  Corrosion form options (continued)

Option Description
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The accuracy of the Floating Gate is dependent on the UT resolution and point 
quantity and is most accurate when using a compression factor of 1 (no compression). 
The floating gate -dB value can be edited in File > Report > Corrosion > Thickness > 
C-scan Configuration. Default value is -6.00 dB.

Export Cscan You can export the thickness C-scan to Excel with the 
current color palette by selecting Cscan. With the sizing 
cursors off, selecting Cscan will export the complete visible 
thickness C-scan display to Excel. With the sizing cursors 
on, only data points between the cursors are exported.

Report Select Report to generate and save a PDF and Excel file of 
the corrosion report. Ensure that the corrosion report 
options in File >Report >Corrosion >Report are set prior 
to running the corrosion report.

Table 49  Corrosion form options (continued)

Option Description

NOTE
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10. Offline Data Analysis

WeldSight software can be used for analyzing data files generated by the software 
itself or by compatible instruments such as the OmniScan series flaw detectors. The 
list of supported file extensions appears in the File > Open dialog box filter.

10.1 File Merge

If your data was acquired in separate files, they can be merged into a single file by 
selecting multiple data files while holding the SHIFT key in the File Open dialog box. 

Figure 10-1  File Merge
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For the files to merge successfully, all selected files must share the same piece 
configuration, and different files types cannot be combined (.odf, .odat, .nde).

To merge data files

1. Select File > Open, and browse to the first data file
2. While holding the SHIFT key select additional data files to be merged. The check 

box will appear in File Merge in the dialog box (see Figure 10-1 on page 157).
3. Select Open. All the beamsets from the merged files become available in the 

beamset list.

The file selection order determines the order in which the beamsets appear in the 
merged file.

10.2 Display Layouts Overview

Default display layouts are available in the command bar and they can be customized 
(see Figure 10-2 on page 158). 

Figure 10-2  Layouts menu

You can create and recall new display layouts. To revert to the default layouts, select 
the Restore Defaults button. (see Figure 10-3 on page 160)

The OmniScan X3 layout list is loaded by default with the installer. It can be changed 
to the FOCUS PX layout list in Preferences.

NOTE

TIP
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To change the default layout list:

1. Select the Preferences icon from the File menu, and select Appearance.
2. Select Load FPX Layouts for setup, acquisition, and analysis or Load X3 Layouts 

for analysis only.
3. Click on the Layouts button (see Figure 10-2 on page 158).
4. In the Layout form, select Update Defaults. The display layout list will load at 

software launch (see Figure 10-3 on page 160).
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Figure 10-3  Layout form
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10.3 Display Header Contextual Menu

You can access a contextual menu by right clicking on the header bar of a display 
(see Figure 10-4 on page 162).

Table 50  Layout form options 

Option Description
Name The display layout name that appears in the drop-down list in the header. 

Create Update Updates the selected layout with the current configuration. 
If no layout is present, one is created in the drop-down list 
in the header.

Delete Deletes the active layout from the drop-down list in the 
header.

Move Up Moves the active layout up one position in the drop-down 
list. Select the layout, and select Move Up successive times 
to position in the layout in the list as desired.

Move Down Moves the active layout down one position in the drop-
down list.

Restore 
Defaults

Replaces the current display layout list with the stored 
defaults. The default layouts configuration is stored in 
C:\OlympusNDT\WeldSight\Layouts\Default 
Layouts.XML.

Update 
Defaults

Replaces the display layouts saved in defaults with the 
current layout list.

Drag and Drop 
Views

The data displays are organized for Setup, Inspection, Processing, and 
Reporting and the display list will update based on the active probe and 
beamset type selected in the command bar. 
Drag any display from the list to an empty window or already configured 
window to update with the new display. Select Create Update after display 
configuration to retain the new layout.
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Figure 10-4  Display header contextual menu

Table 51  Display header contextual menu options 

Menu Item Description
Split Horizontally Splits the current window horizontally.
Split Vertically Splits the current window vertically.
Split Enables a customized layout based on a number of rows 

and columns.
Follows Active 
Beamset

When selected, updates the data display to the active 
beamset in the command bar.

Add Margins When selected, allows a larger zoom window useful when 
using .dxf overlays.

Show Scroll Bars When selected, displays a zoom scroll bar on the axis rulers 
that can resized and repositioned with a mouse or laptop 
touchpad.
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10.4 Display Window Contextual Menu

You can access a contextual menu by right clicking inside a display window 
(see Figure 10-5 on page 163).

Figure 10-5  Display window contextual menu

Zoom Link Links the zoom ruler to any other displays in the layout. 
Deselect Zoom Link on the display to prevent undesired 
zoom linked to another display.

Echo Dynamics When selected, enables the echo dynamic 2D displays 
adjacent to the data display. Echo dynamics are 
configuration from File > Preferences > Appearance > 
Echo dynamics.

Table 51  Display header contextual menu options (continued)

Menu Item Description
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10.5 Dashboard Overview

You can display or hide the dashboard by selecting the dashboard icon  in the 
command bar. The dashboard appears pinned to the left side of the UI. 

The dashboard includes buttons for the acquisition sequence and common tasks. It 
also includes a customizable list for gate trigonometry, amplitude readings, TOF 
readings, and sizing measurements, see Figure 10-6 on page 165.

Table 52  Display window contextual menu options 

Menu Item Description
Zoom in Use these commands to zoom and pan the contents of the 

display window.Zoom out
Pan
Zoom Previous
Select Zoom Allows you to select zoom options for the current window.
Setup Allows horizontal or vertical orientation configuration of the 

current window and reverse axis.
Export Bitmap Allows you to export the display to a file, the clipboard, or to 

a Base64 plot.
Print Allows you to set print options and print different formats, 

including PDF.
Set Data Cursor Places the data cursors and\or beam cursor at the selected 

position.
Set Reference Cursor Places the red reference sizing cursor at the selected position.
Set Measure Cursor Places the blue measure sizing cursor at the selected position.
Delete Indications Deletes selected records from the indication table. Becomes 

available after selecting recorded indications on the corrosion 
thickness C-scan display.

Merge indications Merges selected records into a single record in the indication 
table. Becomes available after selecting recorded indication on 
the corrosion thickness C-scan display.

Set Polar Reference Cursor Places the red polar sizing cursor at the selected position in 
degrees. Available on polar piping display.
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The readings list refreshes according to the selected active beamset in the command 
bar drop-down list or by selecting a data display.

Figure 10-6  Dashboard toolbar

Table 53  Dashboard toolbar options 

Menu Item Description

Inspection sequence

Used for data collection, the inspection sequence button 
will cycle setups, initiate data collection, stop data 
collection for analysis, and return to setup mode with 
successive selections. The inspection sequence soft state is 
displayed in the footer and can be cycled using the 
dashboard button or F1 shortcut key.

Pause

Available during setup mode and data collection, selecting 
pause will freeze the encoder position and allow the 
scanner to be repositioned to the corresponding position, 
or a new position by presetting the value in 
Inspection >Motion Settings >Encoder Preset and 
selecting the encoder preset icon on the Inspection Motion 
form or in the footer (lower-left corner).

Auto 80%

The Auto 80% is used to automatically adjust the gain of 
the signal in gate A of the active beamset to the stored 
calibration threshold in preferences (default 80%).

Assisted analysis

When selected, initiates the assisted analysis filters on all 
beamsets for which auto-execute is enabled. Assisted 
analysis is an add-on to the standard license.
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Snap to peak

The snap to peak button is used to position the data cursor 
to the maximum amplitude peak position of the visible 
data display including zoom, or the zone created by the 
sizing cursors when they are enabled. 
On TOF (time-of-flight) data typical of corrosion, the Snap 
to Peak is used to position the data cursor crosshairs to the 
thinnest TOF position of the visible C-scan including zoom, 
or the zone created by the sizing cursors. Snap to peak can 
also be enabled in File > Preferences > Appearance so that 
it refreshes to the new position any time the sizing cursors 
are repositioned.

Autosizing

Enables and disables auto-sizing. When enabled, will 
position data cursors, beam cursor, and sizing cursors to 
the user defined -X dB drop position after a mouse drag 
over the area of interest. Independent -X dB drop values 
are available for the Scan axis, and the Index/UT axis and 
are configured in File > Sizing > Auto-Sizing Limits.

Indication table toggle

Displays and hides the indication table.

Add record

Adds record to the indication table based on active beamset 
selected in command bar and position of data and beam 
cursors, and sizing cursors.

Delete record

Deletes current selected record from the indication table.

Cursor toggle

Displays or hides the reference and measure sizing cursors 
on the data displays.

Table 53  Dashboard toolbar options (continued)

Menu Item Description
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10.5.1 Readings

Readings are configured independently for PA, Conventional UT, TOFD, and TFM 
probe types. They include gate trigonometry readings, amplitude gate readings, TOF 
gate readings, and sizing cursor statistics that refresh on the active beamset and 
cursors as they are repositioned.

The default readings list can be customized by the user for each probe type in File > 
Readings, or by double-clicking on the readings area in the dashboard.

To customize the default readings lists, select the probe type and source, and toggle 
readings on or off.

The color bar adjacent to the reading indicates gate A (red), gate B (green), or cursor 
statistic (black) (see Figure 10-7 on page 168).
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Figure 10-7  Dashboard
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11. Reporting

WeldSight software reports include an indication table for recording defects, and 
customizable weld and corrosion inspection data generated from Microsoft Excel. The 
reports can be printed or saved to PDF. 

11.1 Indication Table Overview

You can display the indication table from the dashboard. It appears in a fixed area 
below the data windows or can be configured in a custom layout from the data 
display list. 

The indication table is displayed for corrosion or weld, depending on the beamset 
configuration. The table records includes the data and beam cursor positions, sizing 
cursor positions, and weld or corrosion readings associated with the inspection.

The indication table can be included in the report either as a table including all 
records, or as an individual full-page sheet for each record.

11.1.1 Weld Indication Table

When enabled on the dashboard, the weld indication table is displayed for all beamset 
configurations other than zero-degree PA or UT beamsets. The indication table 
includes beamset information, sizing cursor positions, gate trigonometry readings, an 
acceptance decision, and comments for each record.

The reading list that appears in the weld indication table is customizable in File > 
Reports > Weld > Show\Hide Indication Table. It is saved as a system setting.

The flaw types that appear in the pull-down for the weld list can be customized in 
File > Reports > Weld > Flaw Types.
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11.1.2 Corrosion Indication Table

When enabled on the dashboard, the corrosion indication table is displayed for PA 
and UT probe configurations of zero-degree typical of corrosion. The indication table 
includes beamset information, the thickness reading (T-reading), and corrosion 
statistics, such as size and percentage of material loss. 

The list of readings that appear in the corrosion indication table cannot be 
customized.

Corrosion indications records are created manually, one at a time from the dashboard. 
They can also can be created automatically in the corrosion manager.

11.1.3 Creating Indication Table Records

To create a record in the indication table

1. Select Indication Table  on the dashboard to display the indication table.
2. Position data cursors and beam cursor on relative data point, and position sizing 

cursors on each axis around the indication.

3. Select Add Record  on the dashboard to create a record in the table, and add 
an annotation in the data display for indication.

4. To delete a record, highlight a record in the table and select Delete  icon on 
the dashboard, or press the delete key on your keyboard.

11.2 Creating Reports

Reports in WeldSight are generated in PDF format and include a companion 
Microsoft Excel file of the same name. The corrosion and weld reports combine 
information such as the indication table, equipment, component, and beamset 
configuration as sheets that can be turned on or off in File > Report > Weld or > 
Corrosion for inclusion in the report.
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To generate a weld or corrosion report

1. In File > Reports > Corrosion or File > Reports > Weld, select the desired sheets to 
include in the report if different than the installer defaults. 

2. In Analysis > Corrosion Manager, or Analysis > Weld Manager, select Report 
and a file save dialog box appears. 

3. Browse to the desired save location, name the file, and select Save. 
4. The report will generate the companion Excel file of the same name and open the 

report in PDF format if a viewer is installed on the system computer. If any edits 
or additions to the report are required, they can be made in the companion Excel 
file and reprinted or saved to PDF outside of WeldSight software. 

11.3 Customizing Reports

The weld and corrosion reports are created from Excel templates in the WeldSight 
system folder. You can customize WeldSight reports by editing the relevant weld and 
corrosion sheets in the Microsoft Excel templates. You can also import a custom 
Microsoft Excel workbook in the template and include it the report. 

Custom sheets can include existing customer inspection reports built in Microsoft 
Excel, pictures, drawings, or inspection details.

To include custom Microsoft Excel Sheets in the weld or corrosion report

1. Open the weld or corrosion Microsoft Excel template located in 
C:\OlympusNDT\WeldSight\Reports

2. Open the Microsoft Excel workbook containing the sheet to import. On the sheet 
tab at the bottom of workbook, right click and select Move or Copy, and select 
OK.

3. On the copy dialog box select the WeldSight corrosion template file, select Move 
to end, and check Create a copy. Close the Microsoft Excel file that contained the 
new workbook. 

4. Close the WeldSight Microsoft Excel template.

The WeldSight Microsoft Excel template cannot remain open during report creation.
TIP
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5. In File > Reports > Corrosion or > Weld, turn on the Custom sheet option. This 
will include any additional sheets in the template when the report is generated. 

6. In Analysis > Corrosion Manager, or Weld Manager, select Report and a file save 
dialog box appears. 

7. Browse to the desired save location, name the file, and select Save. 
8. The software generates an Microsoft Excel companion file of the same name, 

opens the report in PDF including any additional custom sheets imported to the 
Microsoft Excel template. Information from the data file is stored in the cover 
sheet tab; this data can be mapped to an imported custom Microsoft Excel sheet 
when generating the report.
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12. Reading Abbreviation Reference

The readings appearing on the dashboard are identified by unique abbreviations. 
These abbreviations are described in Table 54 on page 173 and Table 55 on page 176 
(also see “Dashboard” on page 42, and “Readings” on page 58).

Table 54  PA, UT, and TOFD readings 

Reading Description
Cursor Readings 

Ur Position of the reference cursor on the UT axis (not corrected for skips).
Um Position of the measure cursor on the UT axis (not corrected for skips).
Um-r Difference between positions of the reference and measure cursors on the 

UT axis.
Dr Depth of the reference cursor in the part (corrected for skips).
Dm Depth of the measure cursor in the part (corrected for skips).
Dm-r Difference between depth measure and reference cursors in the part.
Ur (TOF) Position in microseconds of the reference cursor on the UT axis.
Um (TOF) Position in microseconds of he measure cursor on the UT axis.
Um-r (TOF) Difference between the reference and measure cursors in microseconds on 

the UT axis.
Ur (TOFD) Position of the TOFD reference cursor on the UT axis (available after TOFD 

linearization).
Um (TOFD) Position of the TOFD measure cursor on the UT axis (available after TOFD 

linearization).
Um-r (TOFD) Difference between the TOFD reference and measure cursors on the UT axis 

(available after TOFD linearization).
Sr Position of the reference cursor on the scan axis.
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Sm Position of the measure cursor on the scan axis.
Sm-r Difference between the reference and measure cursors on the scan axis.
Sm-r (SCS) Difference between the reference and measure cursors on the scan axis 

corrected for pipe curvature.
Ir Position of the reference cursor on the index axis.
Im Position of the measure cursor on the index axis.
Im-r Difference between the reference and measure cursors on the index axis.
Pr Position in degrees of the polar reference cursor.
Pm Position in degrees of the polar measure cursor.
Pm-r Difference in degrees between the polar reference and measure cursors.
A%r Value in percentage of the reference cursor on the amplitude axis.
A%m Value in percentage of the measure cursor on the amplitude axis.
A%m-r Difference in percentage between the reference and measure cursors on the 

amplitude axis
Gate Readings

A% Peak amplitude of signal  in gate A (gate mode dependent).
AdBr Difference in dB between peak signal in gate A and the reference sensitivity 

(gate mode dependent).
DA Depth of the signal in gate A corrected for skips in piece thickness (gate 

mode dependent).
PA Surface distance of the signal in gate A measured from the wedge face (gate 

mode dependent).
SA Sound path distance of the signal in gate A measured from the beam exit 

(gate mode dependent).
ViA Volumetric position of the signal in gate A measured from the weld 

centerline (gate mode dependent).
B% Peak amplitude of signal in gate B (gate mode dependent).
BdBr Difference in dB between peak signal in gate B and the reference sensitivity 

(gate mode dependent).
DB Depth of the signal in gate B corrected for skips in piece thickness (gate 

mode dependent).
PB Surface distance of the signal in gate B measured from the wedge face (gate 

mode dependent).

Table 54  PA, UT, and TOFD readings (continued)

Reading Description
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SB Sound path distance of the signal in gate B measured from the beam entry 
(gate mode dependent).

ViB Volumetric position of the signal in gate B measured from the weld 
centerline (gate mode dependent).

W% Peak amplitude of signal detected in side the weld zone (gate mode 
dependent).

WdBr Difference in dB between peak signal in the weld zone and the reference 
sensitivity (gate mode dependent).

DW Depth of the signal in the weld zone corrected for skips in piece thickness 
(gate mode dependent).

PW Surface distance of the signal in the weld zone measured from the wedge 
face (gate mode dependent).

SW Sound path distance of the signal in weld zone measured from the beam 
entry (gate mode dependent).

ViW Volumetric position of the signal the weld zone measured from the weld 
centerline (gate mode dependent).

Sizing Readings
h\l Height to length ratio as measured by the UT and scan axis cursors.
h\t Height to thickness ratio as measured by the UT axis cursors and piece 

thickness.
Zone Readings

Zmax% Maximum amplitude of the active beamset in cursor zone area (3D).
Imax Position of the Zmax% reading on the index axis.
Dmax Position of the Zmax% reading on the Depth or UT axis.
Smax Position of the Zmax% reading on the scan axis.
ZMergeMax% Maximum amplitude of the volumetric merge in cursor zone area (3D).
IMergeMax Position of the ZMergeMax% reading on the index axis.
DMergeMax Position of the ZMergeMax% reading on the Depth or UT axis.
SMergeMax Position of the ZMergeMax% reading on the scan axis.

Corrosion Readings
Thickness Thickness reading in gate A (gate mode and C-scan source dependent).
Metal Loss Loss of material in percentage from nominal part thickness for current data 

point.
T Scan Pos Position of the thickness reading on the scan axis.

Table 54  PA, UT, and TOFD readings (continued)
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T Index Pos Position of the thickness reading on the index axis.

Table 55  TFM readings 

Reading Description
Cursor Readings

Ur Position of the reference cursor on the UT axis (not corrected for skips).
Um Position of the measure cursor on the UT axis (not corrected for skips).
Um-r Difference between positions of the reference and measure cursors on the 

UT axis.
Dr Depth of the reference cursor in the part (corrected for skips).
Dm Depth of the measure cursor in the part (corrected for skips).
Dm-r Difference between depth measure and reference cursors in the part.
Sr Position of the reference cursor on the scan axis.
Sm Position of the measure cursor on the scan axis.
Sm-r Difference between the reference and measure cursors on the scan axis.
Sm-r (SCS) Difference between the reference and measure cursors on the scan axis 

corrected for pipe curvature.
Ir Position of the reference cursor on the index axis.
Im Position of the measure cursor on the index axis.
Im-r Difference between the reference and measure cursors on the index axis.
Pr Position in degrees of the polar reference cursor.
Pm Position in degrees of the polar measure cursor.
Pm-r Difference in degrees between the polar reference and measure cursors.

Gate Readings
Rectangle% Maximum amplitude of the active beamset in rectangle gate.
Drectangle Depth of the max amplitude signal in rectangle gate.
ViRectangle Volumetric position from centerline of the max amplitude signal in 

rectangle gate.
Polygon% Maximum amplitude of the active beamset in polygon gate.
Dpolygon Depth of the max amplitude signal in polygon gate.
ViPolygon Volumetric position from centerline of the max amplitude signal in polygon 

gate.

Table 54  PA, UT, and TOFD readings (continued)
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Zone Readings
Zmax% Maximum amplitude of the active beamset in cursor zone area (3D).
Imax Position of the Zmax% reading on the index axis.
Dmax Position of the Zmax% reading on the Depth or UT axis.
Smax Position of the Zmax% reading on the scan axis.
ZMergeMax% Maximum amplitude of the volumetric merge in cursor zone area (3D).
IMergeMax Position of the ZMergeMax% reading on the index axis.
DMergeMax Position of the ZMergeMax% reading on the Depth or UT axis.
SMergeMax Position of the ZMergeMax% reading on the scan axis.

Table 55  TFM readings (continued)
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